MobiLink™
Server-Initiated Synchronization

Version 16.0
May 2014
## Contents

About this book ........................................................................................................ v

Server-initiated synchronization ................................................................. 1

  Server-initiated synchronization components ............................................. 2
  Server-initiated synchronization deployment considerations ..................... 3
  Quick start to server-initiated synchronization ............................................. 3

Server-initiated synchronization setup ..................................................... 5

  Push requests ................................................................................................. 5
  Notifiers ............................................................................................................. 10
  Listeners .......................................................................................................... 12
  Light weight pollers ....................................................................................... 18
  Gateways and carriers ..................................................................................... 19

MobiLink server settings for server-initiated synchronization .......... 25

  Server-side settings configured using the ml_add_property system
  procedure .......................................................................................................... 25
  Setting up a Notifier, gateway, or carrier using Sybase Central ................ 26
  Server-side settings configured using the Notifier configuration file ........ 28
  Notifier events .................................................................................................. 30
  Common properties .......................................................................................... 41
  Notifier properties ........................................................................................... 42
  Gateway properties ........................................................................................... 43
  Carrier properties ............................................................................................. 48

MobiLink Listener utility for Windows devices (dbsln) ..................... 49

  Secure Listener deployment ............................................................................. 50
  Listening libraries for Windows devices .......................................................... 50
  MobiLink Listener options for Windows devices ........................................... 51
  MobiLink Listener keywords for Windows devices ......................................... 65
About this book

This book describes MobiLink server-initiated synchronization, a feature that allows the MobiLink server to initiate synchronization or perform actions on remote devices.
Server-initiated synchronization

Note
You can use Sybase Central to administer remote databases, and then use server-initiated remote tasks (SIRT) as an alternative to server-initiated synchronization. For more information, see “Central administration of remote databases” [MobiLink - Server Administration] and “Server-initiated remote tasks (SIRT)” [MobiLink - Server Administration].

MobiLink server-initiated synchronization allows you to initiate synchronization from a consolidated database. You can send push notifications to remote databases, and cause remote databases to update the consolidated database. This MobiLink component provides programmable options for detecting changes in the consolidated database to initiate synchronization, selecting devices to send push notifications to, and determining how devices react to those push notifications.

Example
A trucking organization issues mobile devices to their drivers. Each device runs a database that contains routes and delivery locations. When a driver submits a notice of a traffic disruption, the report is sent to a consolidated database. A server-side MobiLink component called a Notifier detects the report and sends a push notification to other drivers whose routes are affected by the disruption. This push notification causes the remote databases to synchronize so that the drivers can use an alternate route.

The server-initiated synchronization process
In the following illustration, the Notifier checks a consolidated database for changes. The Notifier sends a push notification to a device, resulting in the remote database being synchronized with the consolidated database.
During the server-initiated synchronization process, the following steps occur:

1. Using a query based on business logic, the Notifier checks a consolidated database for changes that need to be synchronized with the remote database.

2. When a change is detected, the Notifier prepares a push notification to send to the device.

3. The Notifier sends the push notification. Push notifications can be sent through a Device Tracker, UDP, SMTP, or SYNC gateway.

4. The Listener compares the subject, content, or sender against a message filter.

5. If the filter conditions are met, an action is initiated. For example, in a typical implementation, an action could run the MobiLink client or launch an UltraLite application.

Server-initiated synchronization components

MobiLink server-initiated synchronization requires the following components:

- **Push requests**  A push request is a row of values in a result set that tells a Notifier that you want to send a push notification to a device. Push requests cause server-initiated synchronizations to occur. Any database application can create push requests, including the Notifier. For example, a push request could be created using a database trigger that is activated when a price changes. See “Push requests” on page 5.

- **A MobiLink Notifier**  A Notifier is a program integrated into the MobiLink server. It frequently checks the consolidated database for push requests. You can control how often the Notifier checks for push requests by specifying its properties. You must specify business logic to check for push requests, and to determine which devices should be notified. A push notification is sent to a device when the Notifier detects a push request. See “Notifiers” on page 10.

- **A MobiLink Listener**  A Listener is a program that runs on a device. It receives push notifications from the Notifier, then uses a message handler to filter messages and initiate an action. In a typical application, actions are synchronization calls, but applications are capable of performing other actions. You can configure the MobiLink Listener to act differently on push notifications from selected server sources, or on push notifications that contain specific content.

On Windows devices, the MobiLink Listener is an executable program that you configure with command line options. To receive push notifications, the device must be turned on and the MobiLink Listener must be running. See “MobiLink Listener utility for Windows devices (dblsn)” on page 49.

- **A light weight poller**  A light weight poller is a device application that polls for push notifications at a specified time interval. Using a light weight poller is an alternative to setting up a gateway, and is recommended because it does not require a persistent connection to the server, and can help extend battery life.

The MobiLink Listener is a light weight poller that you can configure using MobiLink Listener command line options. Alternatively, you can use the light weight polling API to create your own light weight poller.
A gateway (An alternative to a light weight poller)  A gateway provides a Notifier interface for sending push notifications to a device. Gateways are an alternative to light weight pollers. You can send messages using a device tracking gateway, a SYNC gateway, a UDP gateway, or an SMTP gateway. See “Gateways and carriers” on page 19.

Note
You can use Sybase Central to administer remote databases, and then use server-initiated remote tasks (SIRT) as an alternative to server-initiated synchronization. For more information, see “Central administration of remote databases” [MobiLink - Server Administration] and “Server-initiated remote tasks (SIRT)” [MobiLink - Server Administration].

Server-initiated synchronization deployment considerations

Consider the following issues before deploying server-initiated synchronization applications.

Device limitations when using UDP gateways

- The IP address on the device must be addressable directly from the MobiLink server.
- IP tracking for UDP notification does not work if the IP address on a Windows device is not addressable directly from the MobiLink server.

Device tracking limitations

SQL Anywhere 9.0.0 or earlier MobiLink Listeners do not support device tracking. To use device tracking with these MobiLink Listeners, you must set up device tracking manually.

Supported device platforms

The MobiLink Listener is supported on Windows and Windows Mobile.

See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20

Quick start to server-initiated synchronization

Before completing this procedure, you must set up MobiLink for normal synchronization. See “MobiLink - Getting Started”.

1. On the MobiLink server, prepare your consolidated database to store push requests. See “Push request requirements” on page 5.
2. On the MobiLink server, configure Notifier events to create and manage push requests. See “Notifier events and properties configuration” on page 11.

3. On the device, set up a light weight poller. See “Light weight pollers” on page 18.

   If you do not want to use a light weight poller, set up a supported gateway on the MobiLink server. When using an SMTP gateway, you also need to configure a carrier. See “Gateways and carriers” on page 19.

4. On the device, set up a MobiLink Listener to filter messages and perform actions. See “Message handlers” on page 12.

**Other resources**

- Sample applications are installed to the %SQLANYSAMP16%\MobiLink\ directory. All applications related to server-initiated synchronization are located in directories with the **SIS_** prefix.
Server-initiated synchronization setup

The following sections describe how to set up server-initiated synchronization:

- “Push requests”
- “Notifiers”
- “Listeners”
- “Light weight pollers”
- “Gateways and carriers”

Push requests

A push request is a row of values in a result set that a Notifier checks to determine if push notifications need to be sent to a device. A Notifier places the push request inside a push notification then sends the push notification. In a typical server-initiated synchronization set up, a push request contains message content and target device information. Before a push notification can be sent, you need to configure a Notifier event so that the Notifier can detect the push request.

Push request requirements

The requirements for push requests are dependent on the method the MobiLink server uses to communicate with devices. All push requests require subject and content columns.

If you are using light weight pollers to poll for push notifications, you must create a poll key column to identify them.

If you are using gateways to send push notifications, you must create gateway and address columns.

You do not need to create push request columns if they already exist on your system. After you have satisfied the push request requirements, you are can work with them. See “How to work with push requests” on page 7.

Push request requirements when using light weight pollers (recommended)

Create the following columns when you are using light weight pollers to poll for push notifications:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poll key</td>
<td>VARCHAR</td>
<td>The key used to identify a light weight poller. Each light weight poller sends a unique key to identify itself on the MobiLink server.</td>
</tr>
<tr>
<td>Subject</td>
<td>VARCHAR</td>
<td>The subject line of the message.</td>
</tr>
<tr>
<td>Content</td>
<td>VARCHAR</td>
<td>The content of the message.</td>
</tr>
</tbody>
</table>

Push request requirements when using gateways

Unless otherwise specified, create the following columns when using gateways to send push notifications:
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request ID</td>
<td>INTEGER</td>
<td>Optional. The unique ID of a push request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This column name is required for some Notifier events. See “Notifier events” on page 30.</td>
</tr>
<tr>
<td>Gateway</td>
<td>VARCHAR</td>
<td>The name of the gateway to which the message is sent.</td>
</tr>
<tr>
<td>Subject</td>
<td>VARCHAR</td>
<td>The subject line of the message.</td>
</tr>
<tr>
<td>Content</td>
<td>VARCHAR</td>
<td>The content of the message.</td>
</tr>
<tr>
<td>Address</td>
<td>VARCHAR</td>
<td>The destination address of a device.</td>
</tr>
<tr>
<td>Resend interval</td>
<td>VARCHAR</td>
<td>Optional. The time interval between message resends.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The resend interval is useful when using a UDP gateway on an unreliable network. The Notifier assumes that all attributes associated with the push requests do not change; subsequent updates are ignored after the first poll of the request. The Notifier automatically adjusts the next polling interval if a push notification must be sent before the next polling time. You can stop a push request from being sent using synchronization logic in the request_cursor event. Delivery confirmation from the intended MobiLink Listener may stop a subsequent resend. See “request_cursor event” on page 35.</td>
</tr>
<tr>
<td>Time to live</td>
<td>VARCHAR</td>
<td>Optional. The time until the resend expires.</td>
</tr>
</tbody>
</table>

**See also**
- “Notifier events and properties configuration” on page 11
- “request_cursor event” on page 35

**Example**

The following example satisfies the push request requirements for using light weight polling by creating the necessary columns in a SQL Anywhere consolidated database table:

```sql
CREATE TABLE PushRequest (
    req_id INTEGER DEFAULT AUTOINCREMENT PRIMARY KEY,
    poll_key VARCHAR(128),
    subject VARCHAR(128),
    content VARCHAR(128)
)
```

You only need to create this table, or something like it, if the push request columns are not available elsewhere. These columns can exist across multiple tables, in existing tables, or in a view.
How to work with push requests

Generating push requests

Before push requests can be generated, your consolidated database must contain the push request columns required for server-initiated synchronization, and you must be able to obtain the values with a single database query. Push requests are generated automatically when you provide a database query in the request_cursor event that selects push request columns. For more information about push request requirements, see “Push request requirements” on page 5.

Push request generation example for a light weight poller

Assume that a remote device is identified on your MobiLink server as unique_device_ID, and your consolidated database contains a table named PushRequest, which was created using the following SQL statement:

```
CREATE TABLE PushRequest (
    req_id INTEGER DEFAULT AUTOINCREMENT PRIMARY KEY,
    poll_key VARCHAR(128),
    subject VARCHAR(128),
    content VARCHAR(128)
);
```

In this example, you can execute the following SQL statement on the consolidated database to prepare a push request:

```
INSERT INTO PushRequest (poll_key, subject, content) VALUES
    ('unique_device_ID', 'synchronize', 'ASAP');
```

Using the above script to insert values into the PushRequest table does not generate a push request by itself. You must set up a database query in the request_cursor event on the MobiLink server so that the inserted values can be selected and a push request can be generated.

In this example, you can define the following SQL statement for the request_cursor event script on your MobiLink server:

```
SELECT poll_key, subject, content FROM PushRequest;
```

A push request is generated when the unique_device_ID device polls the server for push notifications and the request_cursor event detects data in the PushRequest table. When sent to the device, the push notification subject is defined as synchronize, and the content is defined as ASAP.

Push request limitations

The following table lists the push request limitations for each column:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request ID</td>
<td>INTEGER</td>
<td>This value must be a unique primary key.</td>
</tr>
<tr>
<td>Poll key</td>
<td>VARCHAR</td>
<td>Only required when using light weight pollers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There are no limitations on the poll key.</td>
</tr>
<tr>
<td>Column</td>
<td>Type</td>
<td>Limitation</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Gateway       | VARCHAR  | Only required when using gateways. This value must be set to the name of an enabled gateway. You specify your own custom gateway name, or choose one of the following pre-configured gateway names:  
  - Default-DeviceTracker  
  - Default-SMTP  
  - Default-SYNC  
  - Default-UDP  
  See “Gateways as an alternative to light weight pollers” on page 19. |
| Subject       | VARCHAR  | Avoid using non-alphanumeric characters when setting this value. Braces, chevrons, double quotations, parenthesis, single quotations, and square brackets are reserved for internal use, and should not be used in the subject column.                                                                                                                                                                                                                                                                                                                                           |
| Content       | VARCHAR  | There are no limitations on the message content.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                               |
| Address       | VARCHAR  | Only required when using gateways. For UDP gateways, this value should be an IP address or hostname. Port number suffixes are supported in the following formats:  
  - IP-address:port-number  
  - hostname:port-number  
  For SMTP gateways, this value should be an email address.  
  For SYNC and device tracking gateways, this value should be the recipient name defined with the MobiLink Listener -t+ option. See “-t dblsn option” on page 61. |
<p>| Resend interval | VARCHAR | By default, this value is measured in minutes. You can specify S, M, and H for units of seconds, minutes, and hours, respectively. You can also combine units; for example, 1H 30M 10S informs the Notifier to resend the messages every one hour, thirty minutes, and ten seconds. If this value is null or not specified, the default is to send exactly once, with no resend. |</p>
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time to live</td>
<td>VARCHAR</td>
<td>By default, this value is measured in minutes. You can specify S, M, and H for units of seconds, minutes, and hours, respectively. You can also combine units; for example, 3H 30M 10S informs the Notifier to stop resending messages three hours, thirty minutes, and ten seconds after the initial send. If this value is null or not specified, the default is to send exactly once, with no resend.</td>
</tr>
</tbody>
</table>

**Detecting push requests and sending push notifications**

A Notifier detects a push request by frequently firing the request_cursor event. By default, a script is not specified for this event; you must provide a request_cursor event script so that the Notifier can detect push requests. In a typical application, a request_cursor event script is a SELECT statement. See “request_cursor event” on page 35.

The following example uses the ml_add_property system procedure to create a request_cursor event script for a custom Notifier named Simple. The SELECT statement informs the Notifier to detect push requests from a table named PushRequest.

```
CALL ml_add_property('SIS', 'Notifier(Simple)', 'request_cursor',
  'SELECT poll_key, subject, content FROM PushRequest');
```

**Note**

You must select columns in the same order as they are specified in the push request. See “Push request requirements” on page 5.

For more information about setting up Notifier events, see “MobiLink server settings for server-initiated synchronization” on page 25.

**Deleting push requests**

The Notifier resends push notifications if the information about the notified device is never updated after being sent and satisfied according to your business rules. Once push requests are satisfied, you need to prevent the Notifier from detecting old push requests. You can delete the push requests using a synchronization script if the push notifications were sent for synchronization purposes.

You can use the request_delete event to delete push requests by their request ID, however, your push request must contain a request ID column, and you must enable delivery confirmation.

See:

- “Push request requirements” on page 5
- “request_delete event” on page 36
- “MobiLink server settings for server-initiated synchronization” on page 25
Notifiers

A Notifier is a program integrated into the MobiLink server that frequently checks the consolidated database for push requests. Once push requests are detected, it sends push notifications to devices. A Notifier also executes a series of events, allowing you to create scripts for monitoring data, managing push requests, handling delivery confirmations, and handling errors.

Notifiers start when you first load the MobiLink server. You can have more than one Notifier running within a single instance of the MobiLink server. For an example of how to use multiple Notifiers, see the sample application located in the %SQLANYSAMP16%/MobiLink/SIS_MultipleNotifier.

If a Notifier loses the database connection, it attempts to recover the connection until it regains access. After recovery, the Notifier continues to operate with the same configuration settings.

Notifiers in a MobiLink server farm

In MobiLink 11.0 and earlier, server-initiated synchronization in a MobiLink server farm could cause redundant push notifications, leading to additional synchronizations and increased load on the consolidated database in a MobiLink server farm. A Notifier can now run on every MobiLink server in the farm; the Notifiers, together, ensure that there are no redundant push notifications to the same MobiLink Listener. The mlsrv16 -lsc server option is used to pass information to other servers when they want to connect to the local MobiLink server. See “-lsc mlsrv16 option” [MobiLink - Server Administration].

This feature makes one Notifier the primary, and all other Notifiers secondary. The primary Notifier controls push notifications, either directly or indirectly, via the secondaries. The secondary Notifiers also route MobiLink Listener information to the primary Notifier, so it knows where the MobiLink Listeners are and how to reach them.

If the MobiLink server running the primary Notifier fails, the server farm chooses a new primary Notifier, and notifications continue.

MobiLink Listeners may connect to any MobiLink server in the farm without needing to know which is the primary server.

To use this feature, the following mlsrv16 command line options are required on all MobiLink servers in the farm:

- “-lsc mlsrv16 option” [MobiLink - Server Administration]
- “-notifier mlsrv16 option” [MobiLink - Server Administration]
- “-zs mlsrv16 option” [MobiLink - Server Administration]
Example

On host001:

```
mlsrv16 -notifier -zs ml001 -lsc tcpip(host=host001;port=2439) ...
```

On host007:

```
mlsrv16 -notifier -zs ml007 -lsc tcpip(host=host007;port=2439) ...
```

Notifier events and properties configuration

Notifier events allow you to embed scripts that manage the overall server-initiated synchronization process. For more information about the Notifier event sequence and how they are fired, see “Notifier events” on page 30.

For example, you can configure Notifier events to perform the following tasks:

- Determine what, how, and to whom information is sent in a push request using the request_cursor event.
- Create push requests that respond to changes in the consolidated database using the begin_poll event. (Advanced usage)
- Delete push requests using the request_delete event. (If required)
- Track Notifier polls and clean up table data using the end_poll event. (Advanced usage)

Notifier properties are similar to events. While events manage the notification process, properties manage Notifier behavior. For example, Notifier properties determine how often the Notifier should poll the consolidated database, and if the Notifier should be enabled on startup. Notifier properties and events are configured as server-side settings.

See also

- “MobiLink server settings for server-initiated synchronization” on page 25

Notifier startup

When the MobiLink server loads, it starts all enabled Notifiers. To disable a Notifier, you must set the enable Notifier property value to false. See “Notifier properties” on page 42.

To start your Notifiers, use one of the following methods:

- Configure your Notifiers and run mlsrv16 with the -notifier option specified.
- If your settings are stored in a Notifier configuration file, load the database at the command line by running mlsrv16, and specify the file using the -notifier option. For example, to use a file called myfirst.Notifier, the following command configures the MobiLink server to use the properties and events specified in the file:
Listeners

A Listener is a program that runs on a device. It receives push notifications from a Notifier and initiates actions. Listeners can upload device tracking information to the consolidated database when using a gateway for server-initiated synchronization.

See also

- “Device tracking gateways” on page 19
- “Message handlers” on page 12
- “MobiLink Listener utility for Windows devices (dblsn)” on page 49

Example

The following command starts the MobiLink Listener utility for Windows devices:

```plaintext
dblsn -v2 -m -ot dblsn.log
   -l "poll_connect='host=localhost';
poll_notifier=notifier_name1;
poll_key=sis_user1;
poll_every=10;
sync_key=sync;
subject=sync;
action='start dbmlsync.exe
   -c SERVER=rem1;UID=DBA;PWD=sql
   -ot dbmlsyncOut.txt -qc';"
```

This command loads a MobiLink Listener with verbosity set to level 2, enables message logging, and specifies that the server is located at `localhost`. The `dblsn.log` file is truncated before output is written to it. The MobiLink Listener polls for push notifications every 10 seconds. If the MobiLink Listener receives a push notification where the subject is named `sync`, the MobiLink client application is launched.

For more information about MobiLink Listener command line options for Windows, see “MobiLink Listener options for Windows devices” on page 51.

Message handlers

A message handler is a MobiLink Listener component that scans the message contents of a push notification to initiate an action. It can also be used to specify light weight polling options, such as the server location and the polling frequency.

Message handlers consist of the following components:

- **Filter keywords**   After a push notification is preprocessed, you can use filter keywords to scan the message contents. When a filter condition is met, an action is initiated. For example, you can specify
the **subject** keyword to filter a message that contains a specific subject, or you can specify the **sender** keyword to filter messages received from a specific MobiLink server.

- **An action** An action is initiated after filter conditions are met on a message. In a typical application, you specify an action to initiate synchronization, but you can also perform other operations. To assist with error processing, you can specify an alternative action to handle instances when the original action fails.

- **Poll settings** Poll settings allow you to configure how the MobiLink Listener polls the MobiLink server for push notifications.

- **Options** Options allow you to control remote settings, such as delivery and action confirmation.

You can create a message handler with the `dblsn -l` option. Multiple message handlers can be specified.

**See also**

- “-l dblsn option” on page 56
- “MobiLink Listener keywords for Windows devices” on page 65
- “MobiLink Listener action commands for Windows devices” on page 67

**Message filters**

When a push notification is received by a MobiLink Listener, it extracts a message, which is split up and divided into several keywords. The **message** keyword contains the entire message in a raw format. The message is then divided into **subject**, **content**, and **sender** keywords. These keywords are run through your message filter to determine which actions to initiate. For more information about using these keywords for filtering messages, see “MobiLink Listener keywords for Windows devices” on page 65.

A filter keyword is used to compare part of a push notification to a user-defined phrase. If the two phrases are textually equivalent, then an action is initiated. For more information about preprocessing push notifications for message filtering, see “Message syntax” on page 87.

Filter keywords can be specified by running the MobiLink Listener with the following syntax:

```
    dblsn ... -l "filter-keyword-name='content to filter';action='...'
```

You can use the `-l` option multiple times to create multiple filters, but you must also specify an action for every `-l` instance. Actions are only initiated when all filters are satisfied.

Each of the following keywords can only appear once in a message handler:

- **content** This and the subject keyword are recommended for filtering messages. Use this keyword to filter messages based on their content. For example:

```
    dblsn -l "content='your content filter here';action='...'
```

- **subject** This and the content keyword are recommended for filtering messages. Use this keyword to filter messages based on their subject. For example:

```
    dblsn -l "subject='your subject filter here';action='...'
```
● **message**  Use this keyword to filter messages based on their raw data. Your filter value must match the exact length of the message. This keyword is not recommended since it has a variable structure. For more information about preprocessing push notifications for message filtering, see “Message syntax” on page 87.

● **message_start**  Use this keyword to filter messages based on part of their raw data, starting from the beginning. For more information about preprocessing push notifications for message filtering, see “Message syntax” on page 87.

When you specify this keyword, the MobiLink Listener creates the $message_start and $message_end action variables.

● **sender**  Use this keyword to filter messages based on their sender. This keyword is useful for tracking push notifications sent by a particular Notifier. The value is dependent on the gateway being used. For UDP gateways, it is the IP address of the host of the gateway. For SYNC gateways, it is MobiLink. For SMTP gateways, it depends on your wireless carrier. See “Gateways and carriers” on page 19.

See also

- “MobiLink Listener keywords for Windows devices” on page 65
- “Action variables” on page 15

**Initiation of actions**

When a message matches the conditions of a filter, an action is initiated. For more information about filtering push notifications, see “Message filters” on page 13.

Actions can be specified by running the MobiLink Listener with the following syntax:

```
dbnsn ... -l "...;action='action-command command statement';"
```

The following action commands allow you to perform different tasks when a message is filtered:

● **START**  Start an application, and allow it to run in the background.

● **RUN**  Run an application and wait for it to complete before receiving more push notifications.

● **POST**  Post a window message to a process that is already running. This command can only be used on Windows devices.

● **SOCKET**  Send a message to an application using a TCP/IP connection.

● **DBLSN FULL SHUTDOWN**  Shut down the MobiLink Listener.

See also

- “MobiLink Listener action commands for Windows devices” on page 67
- “Action variables” on page 15
Action variables

Action variables allow you to reference parts of a push notification from a message filter or an action. See “Initiation of actions” on page 14 and “Message filters” on page 13.

How action variables are set

Most action variables are set automatically every time a push notification is received. The variable names are similar to the names specified in the message syntax. For example, message sets the $message action variable, while subject sets $subject, sender sets $sender, and content sets $content. See “Message syntax” on page 87.

Using action variables

Action variables are used in the command line when you run the MobiLink Listener. How they are used is dependent on the message handler, and the action you want to initiate. The following example demonstrates the use of the RUN action command, which is used to initiate the MobiLink client application:

```
dblsn ... -l "subject=publish;action='RUN dbmlsync.exe @dbmlsync.txt -n $content'"
```

This message handler filters messages where the subject is textually equivalent to “publish”. Once filtered, dbmlsync is run with the -n option, passing the $content action variable as a parameter. Assuming that content references the name of a synchronization publication, dbmlsync uses the publication to synchronize the device database with the consolidated database.

The following example demonstrates the use of an action variable to filter a message:

```
dblsn ... -l "subject=$content;action='RUN script.bat""
```

When subject is textually equivalent to content, this message handler filters messages. Once filtered, the device runs a custom batch script.

See also

- “MobiLink Listener action commands for Windows devices” on page 67
- “MobiLink Listener action variables for Windows devices” on page 71
- “Remote ID as a filter” on page 16

Light weight polling option setup

You can use message handlers to handle polling operations. The light weight polling options allow you to specify the location of the server, the Notifier name, the polling frequency, and a poll key. Alternatively, you can use the light weight polling API to specify these properties.

Light weight polling options can be specified by running the MobiLink Listener with the following syntax:

```
dblsn ... -l "poll_connect=protocol-options;
poll_notifier=Notifier-name;
poll_key=identifier-string;
poll_every=number-of-seconds;..."
```
A single message handler can only contain one of each of the following options:

- **poll_connect**  Use this option to specify the protocol options required to connect to the server. Alternatively, you can use the dblsn -x option to specify the default protocol options. The poll_connect option overrides the default protocol options for the message handler.

- **poll_notifier**  Use this option to specify the Notifier used by the MobiLink server to handle push requests. This option is required since the MobiLink server can host multiple Notifiers.

- **poll_key**  Use this option to identify the MobiLink Listener to the Notifier. The MobiLink server uses this value to send push notifications intended for the device. In a typical application, this value should be the remote ID of the device.

- **poll_every**  Use this option to specify how often the MobiLink Listener should poll the Notifier. By default, the MobiLink Listener automatically retrieves this value from the MobiLink server. This value is measured in seconds.

**See also**

- “Push request requirements” on page 5
- “Notifier events and properties configuration” on page 11
- “Light weight pollers” on page 18
- “MobiLink Listener keywords for Windows devices” on page 65
- “Light weight polling API” on page 75

### Advanced message handler features

#### Remote ID as a filter

You can filter messages by remote ID using the dblsn -r option, and the $remote_id action variable.

When synchronizing a SQL Anywhere remote database for the first time, a remote ID file containing the ID of your database is created. The file name is the same as the database, but has the .rid extension, and is stored in the same directory as the database. For UltraLite databases, there is no remote ID file; the remote ID is extracted from the database directly.

When you start the MobiLink Listener, use the dblsn -r option to provide the name and location of the remote ID file or the UltraLite database, then use the dblsn -l option to create your message handler.

You can type the remote ID directly into your message filter. However, remote IDs are GUID by default; the remote ID is not easy to remember unless you provide a meaningful name.

**Note**

In the dblsn command line, you can specify multiple instances of the -r and -l options. The $remote_id action variable used in a -l option is always specified in the -r option that precedes it. So, it is important to specify the -r option before the -l option.

The following example demonstrates the use of multiple remote IDs. It assumes that your device has a SQL Anywhere database called business.db, and an UltraLite database called personal.udb. In this example, ulpersonal is the window class name of the UltraLite application.
Listeners

```
dblsn ... -r "c:\app\db\business.rid"
   -l "subject=$remote_id;action='dbmlsync.exe -k -c dsn=business';"
   -r "c:\ulapp\personal.udb"
   -l "subject=$remote_id;action=post dbas_synchronize to ulpersonal;"
```

See also

- “Action variables” on page 15
- “Remote IDs” [MobiLink - Client Administration]
- “-r dblsn option” on page 60
- “MobiLink Listener action variables for Windows devices” on page 71

Connectivity-initiated synchronization

On Windows devices, you can initiate synchronization when connectivity changes.

When IP connectivity is gained or lost, the device sends a push notification to the MobiLink Listener with the message _IP_CHANGED_. When the device finds a new optimum path to the MobiLink server, it sends a push notification to the MobiLink Listener with the message _BEST_IP_CHANGED_. Using a message handler, you can detect these changes in connectivity and initiate an action.

Identifying any change in connectivity

The _IP_CHANGED_ message indicates that a change in IP connectivity has occurred. A change usually occurs when a device is within range of a Wi-Fi network, when the user makes a RAS connection, or when the user puts the device in a cradle. You can reference the _IP_CHANGED_ message by running the MobiLink Listener with the following syntax:

```
dblsn ... -l "message=_IP_CHANGED_;action='...''
```

The following example demonstrates how to use the _IP_CHANGED_ message. The message handler filters the message, and sends it to the server. If the connection is lost, an error is generated.

```
dblsn -l "message=_IP_CHANGED_;"
   action='"SOCKET port=12345;
   sendText=IP changed: $adapters|$network_names;
   recvText=beeperAck;
   timeout=5';
   continue=yes;"
```

Identifying a change in the optimum path to a MobiLink server

The _BEST_IP_CHANGED_ message indicates that a change in the optimum path to the MobiLink server has occurred. You can reference this message when you run the MobiLink Listener with the following syntax:

```
dblsn ... -x MobiLink-protocol-options -l
   "message=_BEST_IP_CHANGED_;action='...''
```

When filtering the _BEST_IP_CHANGED_ message, the $best_ip action variable, which substitutes the local IP address that represents the best IP connection, can help you initiate useful actions. If there is no IP connection, $best_ip returns 0.0.0.0.
In the following example, the \_BEST_IP_CHANGED\_ message is used to initiate a synchronization when the best IP connection changes. If the connection is lost, an error is generated.

dblsn -x http(host=mlserver.company.com)  
-v2 -m -l 3 -ot dblsn.log  
-l "message=_BEST_IP_CHANGED_;  
action='  
START dbmsync.exe -ra -c SERVER=remote;UID=DBA;PWD=sql -n  
test_pub'"

Note
When testing connectivity-initiated synchronization with your applications, run the MobiLink Listener on a separate computer from your MobiLink server.

See also
- “MobiLink Listener utility for Windows devices (dblsn)” on page 49
- “MobiLink Listener action commands for Windows devices” on page 67
- “MobiLink Listener action variables for Windows devices” on page 71

Light weight pollers

A light weight poller is a device application that polls for push notifications at a specified time interval. Using a light weight poller is an alternative to setting up a gateway, and is recommended because it does not require a persistent connection to the server like the SYNC gateway does, nor does it require a continuous connection like the UDP gateway does.

When a device polls the server, it sends a poll key and a Notifier name. The MobiLink server checks the Notifier name to determine which Notifier should check the cache for push requests. The poll key identifies the device to the Notifier, which uses the poll key to detect push requests intended for the device. Push notifications are sent after the push requests are detected.

Use MobiLink Listener command line options to configure a light weight poller. Alternatively, use the light weight polling API to integrate a light weight poller into your device application.

Note
You can use Sybase Central to administer remote databases, and then use a server-initiated remote task (SIRT) to implement a push notification. For more information, see “Central administration of remote databases” [MobiLink - Server Administration] and “Server-initiated remote tasks (SIRT)” [MobiLink - Server Administration].

See also
- “Light weight polling API” on page 75
- “Light weight polling option setup” on page 15
- “MobiLink Listener keywords for Windows devices” on page 65
Gateways and carriers

Gateways as an alternative to light weight pollers

A gateway is a MobiLink object, stored in MobiLink system tables or a Notifier properties file, that contains information about how to send messages for server-initiated synchronization. They are an alternative to light weight pollers and require a constant network connection.

Gateway properties are configured on a MobiLink server. You can configure multiple gateways on a single MobiLink server.

Supported gateways

The following gateways are supported on the MobiLink server:

- **SYNC gateway** The SYNC gateway is a TCP/IP-based gateway; push notifications are sent through the same protocol as your MobiLink synchronizations.
  
  The default SYNC gateway is named Default-SYNC. Typically, the default gateway settings do not need to be changed.

- **UDP gateway** The UDP gateway sends push notifications through a UDP gateway.
  
  The default UDP gateway is named Default-UDP. Typically, the default gateway settings do not need to be changed. MobiLink Listeners use UDP by default when listening for push notifications.

- **SMTP gateway** The SMTP gateway sends push notifications using an email-to-SMS carrier service.
  
  The default SMTP gateway is named Default-SMTP.

Device tracking gateway

In addition to the supported gateways, you can configure a device tracking gateway which automatically chooses the most appropriate gateway to send push notifications. The default device tracking gateway is Default-DeviceTracker. It is recommended that you use this gateway if you do not want to use a light weight poller.

See also

- “MobiLink server settings for server-initiated synchronization” on page 25
- “SYNC gateway properties” on page 46
- “UDP gateway properties” on page 47
- “SMTP gateway properties” on page 45
- “Device tracking gateways” on page 19

Device tracking gateways

Device tracking allows a MobiLink server to track devices using the remote ID information of a push request. A device tracking gateway uses automatically-tracked IP addresses, phone numbers, and public wireless network provider IDs to deliver push notifications through SYNC, UDP, and SMTP gateways.
The gateway attempts to connect to the device using a SYNC gateway first. If delivery fails, a UDP
gateway is attempted, followed by an SMTP gateway. This feature is useful when you expect device
addresses to change.

A device tracking gateway can have a maximum of three subordinate gateways: one SYNC, one SMTP,
and one UDP. Push notifications are automatically routed to one of the subordinate gateways based on the
device tracking information sent by a MobiLink Listener. By enabling these subordinate gateways, device
address changes are automatically managed by the MobiLink server. When an address changes, the
MobiLink Listener synchronizes with the consolidated database to update the tracking information, which
is located in the ml_device_address system table.

Most 9.0.1 or later MobiLink Listeners support device tracking. If you are using a MobiLink Listener that
does not support device tracking, you can use a device tracking gateway by providing the tracking
information.

See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20
- “Gateways as an alternative to light weight pollers” on page 19
- “Carriers and carrier configuration” on page 23

Setting up device tracking for 9.0.0 MobiLink Listeners

Several system procedures are available to manually set up device tracking for 9.0.0 MobiLink Listeners.
These procedures update the ml_device, ml_device_address, and ml_listening MobiLink system tables on
the consolidated database.

Prerequisites

There are no prerequisites for performing this task.

Context and remarks

You only need to support device tracking if you are using MobiLink Listeners running on SQL Anywhere
9.0.0 or earlier. Device tracking is already supported on all other MobiLink Listeners for Windows
devices.

With manual device tracking, you can address recipients by MobiLink user name without providing
network address information. However, the information cannot be automatically updated by MobiLink if
it changes; you must change it manually. This method is especially useful for SMTP gateways because
email addresses seldom change.

For UDP gateways, you cannot rely on static entries if your IP address changes every time you reconnect.
You can resolve this problem by addressing the host name instead of IP address. However, this solution
slows updates to DNS server tables and can misdirect push notifications. You can also set up system
procedures to update the system tables programmatically.
Task

1. For each device, add a device record to the ml_device system table. For example:

   ```sql
   CALL ml_set_device(
       'myWindowsMobile',
       'MobiLink Listeners for myWindowsMobile - 9.0.1',
       '1',
       'not used',
       'y',
       'manually entered by administrator'
   );
   ```

   The first parameter, `myWindowsMobile`, is a unique user-defined device name. The second parameter contains optional remarks about the MobiLink Listener version. The third parameter specifies a MobiLink Listener version; use 0 for SQL Anywhere 9.0.0 MobiLink Listeners or 2 for post-9.0.0 MobiLink Listeners for Windows. The fourth parameter specifies optional device information. The fifth parameter specifies whether device tracking should be ignored. The final parameter contains optional remarks for this entry.

2. For each device, add an address record to the ml_device_address system table. For example:

   ```sql
   CALL ml_set_device_address(
       'myWindowsMobile',
       'ROGERS AT&T',
       '55111234567',
       'y',
       'y',
       'manually entered by administrator'
   );
   ```

   The first parameter, `myWindowsMobile`, is a user-defined unique device name. The second parameter is a network provider ID, which must match the network_provider_id carrier property. The third parameter is an IP address for UDP. The fourth parameter determines whether to activate this entry for sending push notifications. The fifth parameter specifies whether device tracking should be ignored. The final parameter contains optional remarks for this entry.

3. For each remote database, add a recipient record to the ml_listening system table for each device you added. This maps the device to the MobiLink user name. For example:

   ```sql
   CALL ml_set_listening(
       'myULDB',
       'myWindowsMobile',
       'y',
       'y',
       'manually entered by administrator'
   );
   ```

   The first parameter is a MobiLink user name. The second parameter is a user-defined unique device name. The third parameter determines whether to activate this entry for device tracking addressing. The fourth parameter specifies whether device tracking should be ignored. The final parameter contains optional remarks for this entry.

Results

The specified devices are set up for device tracking.
See also

- “ml_set_device system procedure” on page 82
- “ml_set_listening system procedure” on page 84
- “ml_set_device_address system procedure” on page 83
- “Device tracking gateways” on page 19
- “Carrier properties” on page 48

Quick start to device tracking gateway configuration

The following procedure provides an overview of how to configure a device tracking gateway.

1. Set up a SYNC, UDP, or SMTP gateway.
   
   When you start the MobiLink server, these gateways are already set up with the default settings. For more information about configuring properties or creating your own gateways, see “MobiLink server settings for server-initiated synchronization” on page 25.

   **Note**
   The SMTP gateway requires carrier configuration. See “Carriers and carrier configuration” on page 23.

2. Create a new Notifier and set up your request_cursor event with the following conditions:
   
   - The gateway name must be set to the name of a device tracking gateway you want to use. The default gateway is named Default-DeviceTracker. This name is represented by the first column of the result set.
   
   - The address name must be set to the remote ID of the device. Use the dblsn -t+ option to register the remote ID with the MobiLink server. This name is represented by the fourth column of the result set.
   
   For more information about setting up a request_cursor event, see “request_cursor event” on page 35.

3. Add the MobiLink Listener name to the ml_user system table.
   
   The default MobiLink Listener name is _device_name-dblsn_, where _device_name_ is the name of your device.
   
   Run the MobiLink Listener to view the device name, which can be found in the MobiLink Listener messages window. Alternatively, you can set the device name using the dblsn -e option, or set a different MobiLink Listener name using the dblsn -u option. See “-e dblsn option” on page 55 and “-u dblsn option” on page 63.
   
   For more information about registering MobiLink users, see “MobiLink user creation and registration” [MobiLink - Client Administration].

4. Start a MobiLink Listener with the required options. For more information about starting a MobiLink Listener, see “MobiLink Listener utility for Windows devices (dblsn)” on page 49.
Carriers and carrier configuration

A carrier is a MobiLink object that is stored in MobiLink system tables or a Notifier properties file, that contains information about a public carrier for use by server-initiated synchronization.

You must configure a wireless carrier to send push notifications through an SMTP gateway because the Notifier needs to construct valid email addresses. You must also configure a wireless carrier when using a device tracking gateway with a subordinate SMTP gateway enabled.

Carrier properties, such as the network provider ID and the SMS email prefix, are configured on a MobiLink server. To accommodate multiple carrier services, configure multiple carriers on the MobiLink server.

Sender syntax

When a push notification is received by a MobiLink Listener and preprocessed for message filtering, it is divided into several keywords. The `sender` keyword in a message is an email address, which is generated by the device and varies depending on the wireless carrier. For more information about preprocessing messages, see “Message syntax” on page 87.

The `sender` syntax is in the following format:

```
sender = sms_email_user_prefix phone-number@sms_email_domain
```

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>There are no spaces between <code>sms_email_user_prefix</code> and <code>phone-number</code>.</td>
</tr>
</tbody>
</table>

The `sms_email_user_prefix` and `sms_email_domain` values are carrier properties that should be configured on the MobiLink server. The `phone-number` value is taken from the address column of the `ml_device_address` system table.

To determine the sender syntax, run the MobiLink Listener on a device that uses a carrier service. Enable message logging, and set verbosity to level 2 using the `dblsn -m` and `-v` options. Check the message log after loading the MobiLink Listener.

See also

- “MobiLink server settings for server-initiated synchronization” on page 25
- “Carrier properties” on page 48
MobiLink server settings for server-initiated synchronization

Server-side settings consist of Notifier properties, gateway properties, carrier properties, and Notifier events. To configure these settings, use one of the following methods:

- Sybase Central
- A Notifier configuration file
- The ml_add_property system procedure

The Sybase Central and ml_add_property system procedure methods add events and settings to the ml_property system table.

**Note**
Changes made to server-side settings do not take effect while the MobiLink server is running. To apply new settings, you must shut down and restart the MobiLink server.

If you have already configured server-side settings in the ml_property system table and want to use a Notifier configuration file, the system table settings are always loaded first, followed by the file settings. The Notifier configuration file overwrites existing server-side settings, but the changes are not permanently applied to the consolidated database.

Server-side settings configured using the ml_add_property system procedure

Use the ml_add_property system procedure to configure the server-side settings of a SQL Anywhere consolidated database. You can set these properties and events using Interactive SQL.

**Note**
You must use the ANSI standard when naming your notifiers, gateways, and carriers.

**Common properties syntax**

```
CALL ml_add_property('SIS', '', 'Property', Value);
```

**Notifier properties and events syntax**

```
CALL ml_add_property('SIS', 'Notifier(NotifierName)', 'Event-or-Property', Value);
```

**Gateway properties syntax**

```
CALL ml_add_property('SIS', 'DeviceTracker(DeviceTrackerName)', 'Property', Value);
CALL ml_add_property('SIS', 'SMTP(SMTPName)', 'Property', Value);
CALL ml_add_property('SIS', 'UDP(UDPName)', 'Property', Value);
```
CALL ml_add_property('SIS', 'SYNC(SYNCName)', 'Property', Value);

Carrier properties syntax
CALL ml_add_property('SIS', 'Carrier(CarrierName)', 'Property', Value);

See also
● “ml_add_property system procedure” [MobiLink - Server Administration]

Setting up a Notifier, gateway, or carrier using Sybase Central

Sybase Central provides a graphical user interface for modifying properties and events. You can use Sybase Central to configure multiple Notifiers, gateways, and carriers.

Prerequisites
There are no prerequisites for performing this task.

Context and remarks
You must use the ANSI standard when naming your notifiers, gateways, and carriers.

By configuring your server-side settings through Sybase Central, you do not need to specify a Notifier configuration file at the command line when using the mlsrv16 -notifier option.

Task
1. In Sybase Central, use the MobiLink plug-in to create a MobiLink project for your consolidated database if you have not already created one.

   See “Creating a MobiLink project” [MobiLink - Getting Started].

2. Click View » Folders.

3. In the left pane, expand MobiLink 16, your MobiLink project name, Consolidated databases, your consolidated database name, and then select Notification.

   In the right pane, all available Notifiers, gateways, and carriers appear.

4. Create new Notifiers, gateways, and carriers.

   ● To create a new Notifier, click the Notifiers tab in the right pane, then click File » New » Notifier.

   ● To create a new gateway, click the Gateways tab in the right pane, then click File » New » Gateway.

   ● To create a new carrier, click the Carriers tab in the right pane, then click File » New » Carrier.

5. Select a Notifier, gateway, or carrier to configure.
To set up Notifier properties or events, click the Notifiers tab in the right pane and choose the Notifier that you want to configure.

To set up gateway properties, click the Gateways tab in the right pane and choose the gateway that you want to configure.

To set up carrier properties, click the Carriers tab in the right pane and choose the carrier that you want to configure.

Click File » Properties.

A window appears where you can adjust all settings applicable to the chosen Notifier, gateway, or carrier.

6. Click OK.

**Results**

The Notifier, gateway, or carrier is set up and ready to use.

**Importing server-side settings from a Notifier configuration file**

Use a Notifier configuration file to import server-side settings into the ml_property_table.

**Prerequisites**

There are no prerequisites for performing this task.

**Task**

1. In Sybase Central, use the MobiLink plug-in to create a MobiLink project for your consolidated database if you have not already created one.

   See “Creating a MobiLink project” [MobiLink - Getting Started].

2. Click View » Folders.

3. In the left pane, expand MobiLink 16, your MobiLink project name, Consolidated databases, your consolidated database name, and then select Notification.

4. Click File » Import Settings, and follow the instructions in the wizard.

**Results**

The settings are imported from the Notifier configuration file into the ml_property_table.
Exporting server-side settings to a Notifier configuration file

You can export the server-side settings from the ml_property table into a Notifier configuration file. By exporting the settings, you can create multiple versions of your server-side settings, and you can load a different version using the mlsrv16 -notifier option.

Prerequisites

There are no prerequisites for performing this task.

Task

1. In Sybase Central, use the MobiLink plug-in to create a MobiLink project for your consolidated database if you have not already created one.

   See “Creating a MobiLink project” [MobiLink - Getting Started].

2. Click View » Folders.

3. In the left pane, expand MobiLink 16, your MobiLink project name, Consolidated databases, your consolidated database name, and then select Notification.

4. Click File » Export Settings, and follow the instructions in the wizard.

Results

The specified settings are exported to a Notifier configuration file.

Server-side settings configured using the Notifier configuration file

Server-side settings can be stored in a Notifier configuration file. You can use this file to configure multiple Notifiers, gateways, and carriers.

Note

You must use the ANSI standard when naming your notifiers, gateways, and carriers.

Creating and configuring a Notifier configuration file

A Notifier configuration file can be created using a text editor, or it can be generated from property and event settings exported from Sybase Central. See “Setting up a Notifier, gateway, or carrier using Sybase Central” on page 26.

To view the layout of a typical Notifier configuration file, open the %SQLANYSAMP16%MobiLink\template.Notifier template file. The template file provides examples for configuring server-side properties and events.
When you have configured the necessary settings, save the Notifier configuration file and load your server-side properties and events into the MobiLink server.

**Common properties syntax**

```
Property = Value
```

**Notifier events syntax**

```
Notifier(NotifierName).Event = \ 
# Replace this text with SQL script. \ 
# Be sure to put a backslash (\) at \ 
# the end of every line of code \ 
# if your event requires multiple \ 
# lines of text.
```

**Notifier properties syntax**

```
Notifier(NotifierName).Property = Value
```

**Gateway properties syntax**

```
# For Device tracking gateways:
DeviceTracker(DeviceTrackerName).Property = Value
# For SMTP gateways:
SMTP(SMTPName).Property = Value
# For SYNC gateways:
SYNC(SYNCName).Property = Value
# For UDP gateways:
UDP(UDPName).Property = Value
```

**Carrier properties syntax**

```
Carrier(CarrierName).Property = Value
```

**Loading a Notifier configuration file**

To load a Notifier configuration file into the MobiLink server, run mlsrv16 from the command line with the `-notifier` option specified. For example, to use the server-side settings defined in a CarDealer.Notifier configuration file, run the following command:

```
mlsrv16 ... -notifier "c:\CarDealer.Notifier"
```

If a file is not specified, the `config.Notifier` file is loaded by default.

For more information about the mlsrv16 -notifier option, see “-notifier mlsrv16 option” [MobiLink - Server Administration].

**Note**

To use the default SYNC gateway, you cannot store server-side settings in a Notifier configuration file. You must store them in the `ml_property` system table using an alternative method. See “MobiLink settings for server-initiated synchronization” on page 25.

**Using escape sequences**

The backslash (\) is the escape character. The following is a list of common escape sequences that you can use in a Notifier configuration file:
<table>
<thead>
<tr>
<th>Escape sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\b</td>
<td>Backspace</td>
</tr>
<tr>
<td>\t</td>
<td>Tab</td>
</tr>
<tr>
<td>\n</td>
<td>Linefeed</td>
</tr>
<tr>
<td>\r</td>
<td>Carriage return</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double quote (&quot; )</td>
</tr>
<tr>
<td>'</td>
<td>Single quote (’ )</td>
</tr>
<tr>
<td>\</td>
<td>Backslash (\ )</td>
</tr>
<tr>
<td>\e</td>
<td>Escape</td>
</tr>
</tbody>
</table>

Unicode escape sequences are of the form \uXXXX while ASCII escape sequences are of the form \xXX, where each X represents a hexadecimal digit.

When editing a property or event that requires multiple lines of text, add a single backslash character (\) at the end of each line.

**Notifier events**

Events are fired whenever a Notifier polls a MobiLink Listener. When an event is fired, the SQL script associated with the event is executed. You can incorporate SQL script into any of the Notifier events listed in this section. Although scripting is optional, you must script the request_cursor polling event.

There are three classifications of Notifier events: polling events, connection events, and asynchronous events. Polling events are fired every time a Notifier checks the consolidated database, and include all the events that occur between a begin_poll event and an end_poll event. Connection events are fired during the Notifier database connection. Asynchronous events can be fired at any time during the synchronization process.

Unless otherwise specified, Notifier events can be configured using any of the recommended methods. For more information about configuring Notifier events, see “MobiLink server settings for server-initiated synchronization” on page 25.

When a MobiLink Listener polls the Notifier, these events are fired in the following order:

```
Fire begin_connection event
For each poll {
    Fire begin_poll event
    Fire shutdown_query event
    Fire request_cursor event
    For all requests expired before required confirmation {
        Fire error_handler event
    }
```
Events during polling

Polling events are a classification of Notifier events that are fired every time a Notifier checks the consolidated database. These events include all the events that occur between a begin_poll event and an end_poll event.

begin_poll event

This polling event accepts SQL script and is fired before the Notifier checks the consolidated database for push requests. The value is null by default, so this event is not fired.

See also

- “Push requests” on page 5
- “Notifier events” on page 30
- “MobiLink server settings for server-initiated synchronization” on page 25

Example

This example creates a push request for a Notifier named Notifier A. It uses a SQL statement that inserts rows into a table named PushRequest. Each row in this table represents a message to send to an address. The WHERE clause determines which push requests are inserted into the PushRequest table.

To use the ml_add_property system procedure with a SQL Anywhere consolidated database, run the following command:

```sql
ml_add_property(
    'SIS',
    'Notifier(Notifier A)',
    'begin_poll',
    'INSERT INTO PushRequest
        (gateway, mluser, subject, content)
    SELECT ''MyGateway'', DISTINCT mluser, ''sync'',
        stream_param
    FROM MLUserExtra, mluser_union, Dealer
    WHERE MLUserExtra.mluser = mluser_union.name
    AND (push_sync_status = ''waiting for request''
        OR datediff( hour, last_status_change, now() ) > 12 )
    AND ( mluser_union.publication_name is NULL
        OR mluser_union.publication_name =''FullSync'' )
    AND Dealer.last_modified > mluser_union.last_sync_time'
);
```

end_poll event

This polling event accepts SQL script and is fired after the Notifier checks the consolidated database for push requests. The value is null by default, so this event is not fired.
You can use this event to perform table cleanup or to log the results of a poll.

See also
- “Notifier events” on page 30
- “MobiLink server settings for server-initiated synchronization” on page 25

**error_handler event**

Configure this event to indicate when a transmission fails or was not confirmed. For example, when a transmission fails, you can use this event to insert a row in an audit table or to send a push notification.

The following table details the parameters that can be captured using the error_handler event:

<table>
<thead>
<tr>
<th>Script parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| request_option (out)    | Integer| Controls what the Notifier does to the push request after the error handler returns. The output can be one of the following values:  
  - 0: Perform default action based on the error code and log the error.  
  - 1: Do nothing.  
  - 2: Execute the request_delete event.  
  - 3: Attempt to deliver to a secondary gateway. |
| error_code (in)         | Integer| Use one of the following values for the error code:  
  - -1: The request timed out with confirmation of success.  
  - -8: An error occurred during delivery attempt. |
<p>| request_id (in)         | Integer| Identifies the request.                                                   |
| gateway (in)            | Varchar| Specifies the gateway associated with the push request.                  |</p>
<table>
<thead>
<tr>
<th>Script parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| address (in)     | Var-char | Specifies the address associated with the push request. For security reasons, when the optional Notifier error handler is invoked, an asterisk (*) is substituted for any character in the subject or content of the notification that is not one of the following:  
  - alphanumeric characters  
  - period  
  - colon  
  - minus sign  
  - plus sign  
  - underscore  
  The value sent in the notification is the same as the original value. |
| subject (in)     | Var-char | Specifies the subject associated with the push request. For security reasons, when the optional Notifier error handler is invoked, an asterisk (*) is substituted for any character in the subject or content of the notification that is not one of the following:  
  - alphanumeric characters  
  - period  
  - colon  
  - minus sign  
  - plus sign  
  - underscore  
  The value sent in the notification is the same as the original value. |
| content (in)     | Var-char | Specifies the content associated with the push request. For security reasons, when the optional Notifier error handler is invoked, an asterisk (*) is substituted for any character in the subject or content of the notification that is not one of the following:  
  - alphanumeric characters  
  - period  
  - colon  
  - minus sign  
  - plus sign  
  - underscore  
  The value sent in the notification is the same as the original value. |
Note
This event requires the use of a system procedure. You cannot configure this event directly using Sybase Central. See “MobiLink server settings for server-initiated synchronization” on page 25.

See also
● “Notifier events” on page 30
● “MobiLink server settings for server-initiated synchronization” on page 25

Example
In the following example, you create a table called CustomError and log errors to the table using a stored procedure called CustomErrorHandler. The output parameter Notifier_opcode is always 0, which means that default Notifier handling is used.

```sql
CREATE TABLE CustomError(
    error_code  integer,
    request_id  integer,
    gateway     varchar(255),
    address     varchar(255),
    subject     varchar(255),
    content     varchar(255),
    occurAt     timestamp not null default timestamp
);

CREATE PROCEDURE CustomErrorHandler(
    out @Notifier_opcode integer,
    in  @error_code   integer,
    in  @request_id  integer,
    in  @gateway     varchar(255),
    in  @address     varchar(255),
    in  @subject     varchar(255),
    in  @content     varchar(255)
)
BEGIN
    INSERT INTO CustomError(
        error_code,
        request_id,
        gateway,
        address,
        subject,
        content)
    VALUES(
        @error_code,
        @request_id,
        @gateway,
        @address,
        @subject,
        @content
    );
    SET @Notifier_opcode = 0;
END
```

To use this ml_add_property system procedure with a SQL Anywhere consolidated database, run the following command:

```sql
call ml_add_property(
    'SIS',
    'Notifier(myNotifier)',
```
Alternatively, you can fire this event by adding the following line to a Notifier configuration file:

```sql
Notifier(myNotifier).error_handler = call CustomErrorHandler(?,?,?,?,?,?,?);
```

Run the file using the mlsrv16 -notifier option. For more information about how to configure a Notifier configuration file, see “Server-side settings configured using the Notifier configuration file” on page 28.

---

**request_cursor event**

This polling event accepts SQL script and is fired to detect push requests. You must configure this event.

**Fetching push requests when using a light weight poller (recommended)**

When this event contains up to three columns in a result set, the Notifier acknowledges that there is no persistent connection between the server and the device, and that a device must poll the Notifier before push notifications can be sent. The Notifier caches the result set before sending push notifications. The MobiLink server identifies the device by the poll key, which is sent by the device every time the device polls the Notifier.

The result set of this event must contain the following columns in the specified order:

- Poll key
- Subject (optional)
- Content (optional)

**Fetching push requests when using a gateway**

When this event contains more than three columns in a result set, the Notifier acknowledges that a persistent connection exists between the server and the device, and then sends push notifications using a gateway when push requests are detected.

The result set of this event must contain the following columns in the specified order:

- Request ID (optional)
- Gateway
- Subject
- Content
- Address
- Resend interval (optional)
- Time to live (optional)
Example

The following example uses the ml_add_property system procedure to create a request_cursor event script for a custom Notifier named Simple. The SELECT statement tells the Notifier to detect push requests from a table named PushRequest.

```sql
CALL ml_add_property('SIS', 'Notifier(Simple)', 'request_cursor',
    SELECT poll_key,
    subject,
    content
  FROM PushRequest
);
```

It is recommended that you include a WHERE clause in your script to filter out requests that have already been sent. For example, you can add a push request column to track the moment you inserted a request, and then use a WHERE clause in this event to filter out requests that were inserted before the last time the user synchronized.

request_delete event

This polling event accepts SQL script and is fired to perform cleanup operations when the need for push request deletion is detected. It accepts the request ID as a parameter and is executed per request ID. Your request_cursor event must contain a request ID column to use the request_delete event. You can reference the request ID using a named parameter or a question mark ( ? ). This event is optional if you have already assigned cleanup operations to another process or event, such as the end_poll event.

The Notifier can use the DELETE statement to remove the following forms of push requests:

- **Implicitly dropped** These push requests appeared previously but did not appear in the current set of requests obtained from the request_cursor event.

- **Confirmed** These are push requests confirmed as delivered.

- **Expired** These push requests expired based on their resend attributes and the current time. Requests without resend attributes are considered expired even if they appear in the next request.

You can use the request_delete event to prevent expired or implicitly dropped requests from being deleted. For example, the CarDealer sample in the `%SQLANYSAMP16%\MobiLink\SIS_CarDealer` directory uses the request_delete event to set the status field of the PushRequest table to 'processed'.

```sql
UPDATE PushRequest SET status='processed' WHERE req_id = ?
```

The begin_poll event in the sample uses the last synchronization time to check if remote devices are up-to-date before eliminating processed push requests.
See also

- “Notifier events” on page 30
- “MobiLink server settings for server-initiated synchronization” on page 25

**shutdown_query event**

This polling event accepts SQL script and is fired after a begin_poll event. The return value specifies the shutdown state of the Notifier. The value is null by default, so this event is not fired.

To shut down the Notifier, set up your SQL script to return "yes"; otherwise, set it to return "no". If the Notifier shuts down, the end_poll event is not fired.

When storing the shutdown state in a table, use the end_connection event to reset the state.

See also

- “end_connection event” on page 38
- “Notifier events” on page 30
- “MobiLink server settings for server-initiated synchronization” on page 25

**Example**

The following example uses the ml_add_property system procedure to create a shutdown_query event script for a custom Notifier named Simple. The SELECT statement informs the Notifier to shut down if the tooManyNotifierErrors method returns true.

```
CALL ml_add_property('SIS', 'Notifier(Simple)', 'shutdown_query',
'SELECT
    IF tooManyNotifierErrors() THEN
        'yes'
    ELSE
        'no'
ENDIF');
```

**Connection events**

Connection events are a classification of Notifier events that are fired during the Notifier database connection.

**begin_connection event**

This event accepts SQL script and is fired after the Notifier connects to the consolidated database, but before it checks for push requests. The value is null by default, so this event is not fired.

You can use this event to create temporary tables or variables. You should not use this event to change isolation levels. To control isolation levels, use the isolation property.

If the Notifier loses the connection to the consolidated database, it re-runs this event immediately after reconnecting.
end_connection event

This event accepts SQL script and is fired just before the Notifier disconnects from the consolidated
database. The value is null by default, so this event is not fired.

You can use this event to clean up temporary storage, such as SQL variables and temporary tables.

See also

- “Notifier properties” on page 42
- “Notifier events” on page 30
- “MobiLink server settings for server-initiated synchronization” on page 25

Asynchronous events

Asynchronous events are a classification of Notifier events that can be fired at any time during the
synchronization process.

confirmation_handler event

Configure this event to handle delivery confirmation information uploaded by MobiLink Listeners. If the
status parameter returns 0, then the push request identified by request_id was successfully received by the
MobiLink Listener identified by the remote_device parameters.

You can use the request_option parameter to initiate an action in response to the delivery confirmation. If
request_option is 0, the confirmation_handler event initiates the default action, where the request_delete
event is executed to delete the original push request. If the device sending the delivery confirmation does
not match the device identified by the request_id, the default action is to send the original push request
through a secondary gateway.

Note
Use the dblsn -x option to allow MobiLink Listeners to upload delivery confirmation information. Use the
dblsn -ni option if you want delivery confirmation but do not want IP tracking. See “MobiLink Listener
options for Windows devices” on page 51.

Note
This event requires the use of a system procedure. You cannot configure this event directly using the
Sybase Central method. See “MobiLink server settings for server-initiated synchronization” on page 25.

The following parameters can be captured using the confirmation_handler event:
<table>
<thead>
<tr>
<th>Script parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>request_option</td>
<td>Integer</td>
<td>Controls what the Notifier does to the request after the handler returns. The following values can be returned:</td>
</tr>
<tr>
<td></td>
<td>(out)</td>
<td>- 0: Perform default Notifier action based on the value of the status parameter. If status indicates that the responding device is the target one, then the Notifier deletes the request; otherwise the Notifier attempts to deliver on a secondary gateway.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 1: Do nothing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 2: Execute Notifier.request_delete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 3: Attempt to deliver to a secondary gateway.</td>
</tr>
<tr>
<td>status</td>
<td>Integer</td>
<td>The situation summary. The status can be used during development to identify problems such as incorrect filters and handler attributes. The following values can be returned:</td>
</tr>
<tr>
<td>(in)</td>
<td></td>
<td>- 0: Received and confirmed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-2: Right respondent but the message was rejected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-3: Right respondent and the message was accepted but the action failed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-4: Wrong respondent and the message was accepted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-5: Wrong respondent and the message was rejected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-6: Wrong respondent. The message was accepted and the action succeeded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-7: Wrong respondent. The message was accepted but the action failed.</td>
</tr>
<tr>
<td>request_id</td>
<td>Integer</td>
<td>The request ID. Your request_cursor event must contain a request ID column to use the confirmation_handler event.</td>
</tr>
<tr>
<td>(in)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>remote_code</td>
<td>Integer</td>
<td>The summary reported by the MobiLink Listener. The following values can be returned:</td>
</tr>
<tr>
<td>(in)</td>
<td></td>
<td>- 1: Message accepted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 2: Message rejected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 3: Message accepted and action succeeded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 4: Message accepted and action failed.</td>
</tr>
<tr>
<td>remote_device</td>
<td>Varchar</td>
<td>The device name of the responding MobiLink Listener.</td>
</tr>
<tr>
<td>(in)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>remote_mluser</td>
<td>Varchar</td>
<td>The MobiLink user name of the responding MobiLink Listener.</td>
</tr>
<tr>
<td>(in)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>remote_action_return</td>
<td>Varchar</td>
<td>The return code of the remote action.</td>
</tr>
</tbody>
</table>
### Script parameters

<table>
<thead>
<tr>
<th>Script parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>remote_action</td>
<td>Varchar</td>
<td>Reserved for the action command.</td>
</tr>
<tr>
<td>gateway</td>
<td>Varchar</td>
<td>The gateway associated with the request.</td>
</tr>
<tr>
<td>address</td>
<td>Varchar</td>
<td>The address associated with the request.</td>
</tr>
<tr>
<td>subject</td>
<td>Varchar</td>
<td>The subject associated with the request.</td>
</tr>
<tr>
<td>content</td>
<td>Varchar</td>
<td>The content associated with the request.</td>
</tr>
</tbody>
</table>

### See also

- “Notifier events” on page 30
- “MobiLink server settings for server-initiated synchronization” on page 25
- “Gateway properties” on page 43

### Example

In the following example, you create a table called CustomConfirmation and then log confirmations to it using a stored procedure named CustomConfirmationHandler. The output parameter request_option is always set to 0, which means that default Notifier handling is used.

```sql
CREATE TABLE CustomConfirmation(
    error_code   integer,
    request_id   integer,
    remote_code integer,
    remote_device varchar(128),
    remote_mluser varchar(128),
    remote_action_return varchar(128),
    remote_action varchar(128),
    gateway varchar(255),
    address varchar(255),
    subject varchar(255),
    content varchar(255),
    occurAt timestamp not null default timestamp
);

CREATE PROCEDURE CustomConfirmationHandler(
    out @request_option integer,
    in  @error_code   integer,
    in  @request_id   integer,
    in  @remote_code  integer,
    in  @remote_device varchar(128),
    in  @remote_mluser varchar(128),
    in  @remote_action_return varchar(128),
    in  @remote_action varchar(128),
    in  @gateway      varchar(255),
    in  @address      varchar(255),
    in  @subject      varchar(255),
    in  @content      varchar(255)
)
BEGIN
    INSERT INTO CustomConfirmation(
        error_code,
        request_id,
```

---

Copyright © 2014, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0
To use the ml_add_property system procedure with a SQL Anywhere consolidated database, run the following command:

```sql
call ml_add_property(
    'SIS',
    'Notifier(myNotifier)',
    'confirmation_handler',
```

Alternatively, you can call this event by adding the following line to a Notifier configuration file:

```sql
Notifier(myNotifier).confirmation_handler = call
```

Run the file using the mlsrv16 -notifier option. For more information about how to configure a Notifier configuration file, see “Server-side settings configured using the Notifier configuration file” on page 28.

## Common properties

Common properties are shared between Notifiers, gateways, and carriers. All common properties are optional. For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.
Proper
ty Value Description

verbosity { 0 | 1 | 2 | 3 } Specifies the verbosity level for Notifiers, gateways, and carriers. The following values can be used:

* 0: No trace.
* 1: Startup, shutdown, and property trace.
* 2: Display notifications.
* 3: Full-level trace.

The default value is 0.

### Notifier properties

Notifier properties allow you to change the behavior of a Notifier. All Notifier properties are optional. For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect_string</td>
<td>connection_string</td>
<td>Overrides the default connection behavior used to connect to a database. The default value is <code>anywhere.ml.script.ServerContext</code>, which uses the connection string specified in the mlsrv16 command line. It may be useful to connect to another database when you want notification logic and data to be separate from your synchronization data. Most deployments do not set this property.</td>
</tr>
<tr>
<td>enable</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>gui</td>
<td>{ yes</td>
<td>no }</td>
</tr>
</tbody>
</table>
### Gateway properties

By default, four preconfigured gateways are created when you start the MobiLink server. They are installed when you run the MobiLink setup scripts for your consolidated database. The default gateways are named as follows:

- Default-DeviceTracker gateway

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| isolation                 | { 0 | 1 | 2 | 3 }         | Specifies the isolation level of the Notifier's database connection. The following values can be used:  
  - **0**: Read uncommitted.  
  - **1**: Read committed.  
  - **2**: Repeatable read.  
  - **3**: Serializable.  
  
  The default value is **1**. Higher levels increase contention, but could adversely affect performance. Isolation level **0** allows reads of uncommitted data, which could get rolled back. |
| poll_every                | number{ s | m | h } | Specifies the amount of time to wait before confirmations timeout. The following is a list of acceptable time units:  
  - **s**: Denotes seconds.  
  - **m**: Denotes minutes.  
  - **h**: Denotes hours.  
  
  The default value is **1m**. Time units can be combined in the **HH:mm:ss** format. If a time unit is not specified, time is measured in seconds. |
| shared_database_connection | { yes | no }        | Specifies whether Notifiers should share database connections. The default value is **no**. Notifiers can only share connections when their isolation levels are the same.  
  
  Specify **yes** to conserve resources without incurring performance penalties. Connection sharing is not possible in some situations, such as when applications use non-unique SQL variable names among Notifiers. |
You should not remove the default gateways or change their names. It is recommended that you create additional gateways with different names.

You should not need to change the properties defined in DefaultSYNC and DefaultUDP, but you must provide SMTP server information to the DefaultSYNC gateway. You should use the default gateways but, if required, you can use an alternative configuration. This section provides procedures for customizing gateway properties.

### Device tracking gateway properties

Device tracking gateway properties allow you to change the behavior of a device tracking gateway. All device tracking gateway properties are optional. For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>confirm_action</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>confirm_delivery</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>description</td>
<td>description_text</td>
<td>Describes the gateway.</td>
</tr>
<tr>
<td>enable</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>smtp_gateway</td>
<td>smtp_gateway_name</td>
<td>Specifies the name of the SMTP subordinate gateway. The default value is DefaultSMTP. A device tracking gateway can only use one SMTP gateway. The gateway must be enabled.</td>
</tr>
<tr>
<td>sync_gateway</td>
<td>sync_gateway_name</td>
<td>Specifies the name of the SYNC subordinate gateway. The default value is DefaultSYNC. A device tracking gateway can only use one SYNC gateway. The gateway must be enabled.</td>
</tr>
</tbody>
</table>
**udp_gateway**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>udp_gateway_name</td>
<td></td>
<td>Specifies the name of the UDP subordinate gateway. The default value is <strong>DefaultUDP</strong>. A device tracking gateway can only use one UDP gateway. The gateway must be enabled.</td>
</tr>
</tbody>
</table>

**SMTP gateway properties**

SMTP gateway properties allow you to change the behavior of an SMTP gateway. The server property is required; all other SMTP gateway properties are optional. For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>confirm_action</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>confirm_delivery</td>
<td>{ yes</td>
<td>no }</td>
</tr>
</tbody>
</table>
| confirm_timeout                 | number { s | m | h } | Specifies the amount of time to wait before confirmations timeout. The following is a list of acceptable time units:  
   - s: Denotes seconds.  
   - m: Denotes minutes.  
   - h: Denotes hours.  
   The default value is **1m**. Time units can be combined in the **HHh MMm SSs** format. If a time unit is not specified, time is measured in seconds. |
| description                     | description_text | Describes the gateway. |
| enable                          | { yes | no }       | Specifies whether the SYNC gateway should be used. |
| Listeners_are_900               | { yes | no }       | Specifies whether all MobiLink Listeners are SQL Anywhere 9.0.0 clients. The default value is **no**. For SQL Anywhere 9.0.1 clients or later, leave this value at **no**. |
| password                        | password         | Specifies the password for the SMTP service. This is required by some services. |
| sender                          | SMTP_address     | Specifies the sender address of SMTP push notifications. The default value is **anonymous**. |
### Property Value Description

**server**

*IP_address_or_hostname*

Specifies the IP address or host name of the SMTP server used to send messages to a MobiLink Listener. The default value is `mail`.

**user**

*username*

Specifies the user name of the SMTP service. This is required by some services.

### SYNC gateway properties

SYNC gateway properties allow you to change the behavior of a SYNC gateway. All SYNC gateway properties are optional. For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>confirm_action</td>
<td>{yes</td>
<td>no}</td>
</tr>
<tr>
<td>confirm_delivery</td>
<td>{yes</td>
<td>no}</td>
</tr>
</tbody>
</table>
| confirm_timeout     | number \{s | m | h\}                     | Specifies the amount of time to wait before confirmations timeout. The following is a list of acceptable time units:
  - s: Denotes seconds.
  - m: Denotes minutes.
  - h: Denotes hours.
  The default value is `1m`. Time units can be combined in the `HHh MMm SSs` format. If a time unit is not specified, time is measured in seconds. |
| description         | description_text                    | Describes the gateway. |
| enable              | \{yes | no\}                           | Specifies whether the SYNC gateway should be used. |
| Listeners_are_900   | \{yes | no\}                           | Specifies whether all MobiLink Listeners are SQL Anywhere 9.0.0 clients. The default value is `no`. Leave this value at `no` for SQL Anywhere 9.0.1 clients or later. |
# UDP gateway properties

UDP gateway properties allow you to change the behavior of an UDP gateway, such as the IP address and the port number. All UDP gateway properties are optional. For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>confirm_action</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>confirm_delivery</td>
<td>{ yes</td>
<td>no }</td>
</tr>
</tbody>
</table>
| confirm_time-out  | number { s | m | h } | Specifies the amount of time to wait before confirmations timeout. The following is a list of acceptable time units:  
  - s: Denotes seconds.  
  - m: Denotes minutes.  
  - h: Denotes hours.  
  The default value is 1m. Time units can be combined in the $HHh \ MMm \ SSs$ format. If a time unit is not specified, time is measured in seconds. |
| description       | description_text     | Describes the gateway.                                                        |
| enable            | { yes | no }           | Specifies whether the UDP gateway should be used.                             |
| Listeners_are_900 | { yes | no }           | Specifies whether all MobiLink Listeners are SQL Anywhere 9.0.0 clients. The default value is no. For SQL Anywhere 9.0.1 clients or later, leave this value at no. |
| Listener_port     | port_number          | Specifies the port that the remote devices uses to send UDP packets. The default value is 5001. |
| sender            | IP_address_or_hostname | Used for multi-homed hosts only. Specifies the IP address or hostname of the sender. The default value is localhost. |
| sender_port       | port_number          | Specifies the port number used to send UDP packets. By default, a free port number is randomly assigned by the operating system. |
Carrier properties

Carrier properties allow you to change the behavior of a wireless carrier configuration, which provides information about mapping automatically-tracked phone numbers and network providers to email addresses. All carrier properties are optional, and are only required if you are using an SMTP gateway.

For more information about setting these properties, see “MobiLink server settings for server-initiated synchronization” on page 25.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enable</td>
<td>{ yes</td>
<td>no }</td>
</tr>
<tr>
<td>description</td>
<td>description_text</td>
<td>Describes the carrier.</td>
</tr>
<tr>
<td>network_provider_id</td>
<td>id_text</td>
<td>Specifies the network provider ID. To use SMS on Windows Mobile Phone edition, set this property to <em>generic</em>.</td>
</tr>
<tr>
<td>sms_email_domain</td>
<td>domain_name</td>
<td>Specifies the domain name of the carrier.</td>
</tr>
<tr>
<td>sms_email_user_prefix</td>
<td>prefix_name</td>
<td>Specifies the prefix used in email addresses.</td>
</tr>
</tbody>
</table>
MobiLink Listener utility for Windows devices (dblsn)

This section provides information about MobiLink Listener utility for Windows devices, including information about Listening libraries, Listener options and keywords, Listener action commands and variables, and Listener configuration.

Syntax

```
  dblsn [ options ] -l message-handler [ -l message-handler... ]
```

```
  message-handler :
  [ polling-option;... ] [ filter;... ] action; [ option;... ]
```

```
  polling-option :
  [ ;poll_connect = string ]
  [ ;poll_notifier = string ]
  [ ;poll_key = string ]
  [ ;poll_every = number ]
```

```
  option :
  [ ;continue = yes ]
  [ ;confirm_action = yes ]
  [ ;confirm_delivery = no ]
  [ ;maydial = no ]
```

```
  filter :
  [ subject = string ]
  [ content = string ]
  [ message = string | message_start = string ]
  [ sender = string ]
```

```
  action :
  action = command[;altaction = command]
```

```
  command :
  START program [ program-arguments ]
  RUN program [ program-arguments ]
  POST window-message TO { window-class-name | window-title }
  tcpip-socket-action
  | DBLSN FULL SHUTDOWN
```

```
  tcpip-socket-action :
  SOCKET port=app-port
  [ ;host=app-host ]
  [ ;sendText=text1 ]
  [ ;recvText= text2 [ ;timeout=num-sec ] ]
```

```
  window-message : string | message-id
```
Remarks

The -l message-handler for dblsn is a semicolon separated name-equal-value pair. String values in the name-equal-value pairs needs to be surrounded by single quotes, otherwise dblsn fails to start up if the string value contains a semicolon.

See also

- “MobiLink Listener options for Windows devices” on page 51
- “MobiLink Listener keywords for Windows devices” on page 65
- “MobiLink Listener action commands for Windows devices” on page 67
- “MobiLink Listener action variables for Windows devices” on page 71

Secure Listener deployment

The Listener receives external notifications and can invoke an application while passing in information from the notifications. External notifications could, in theory, be used to inject harmful data causing undesirable results. Care must be taken to secure the Listener deployment.

It is recommended that you implement the following recommendations to secure the Listener:

- Use the dblsn -x option and specify a TLS-based protocol, HTTPS for example, to verify the server (the notifier) and secure the network communications.

- Do not use SMS or UDP listeners because they are unsecured. SMS and UDP are both disabled by default.

- All actions configured via the dblsn -l option must either reject invalid input, or be guaranteed to have no harmful effects when arbitrary input is received.

- Do not invoke a very powerful or a very general application, for example cmd.com, in an action specification via the dblsn -l option. Deploy and configure a very specific application that does exactly what you need, and no more, and rejects invalid input.

- Use message filters to limit the invocation of actions.

- Avoid using action variables to specify functionality.

See also

- “-x dblsn option” on page 64
- “Message filters” on page 13
- “MobiLink Listener keywords for Windows devices” on page 65
- “-l dblsn option” on page 56

Listening libraries for Windows devices

The MobiLink Listener comes with a UDP listening library, lsn_udp16.dll, which is loaded by default.
When using an SMTP gateway, you must specify an SMTP listening library. You can specify a library with the dblsn -d option, and specify library options with the dblsn -a option.

**UDP (lsn_udp16.dll)**

The following is a list of options supported by the UDP listening library:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port=port-number</td>
<td>This option specifies the port number to listen to. The default port is 5001.</td>
</tr>
<tr>
<td>Timeout=seconds</td>
<td>This option specifies the maximum blocking time of a read operation on the UDP listening port. This value must be smaller than the polling interval of the UDP listening thread. The default is 0.</td>
</tr>
<tr>
<td>ShowSenderPort</td>
<td>This option reveals the sender port number in all occurrences of the $sender action variable. By default, the port number is hidden. When this option is specified, the port number is appended at the end of the sender address with the :port-number syntax.</td>
</tr>
<tr>
<td>HideWSAErrorBox</td>
<td>Suppresses the error window showing errors on socket operations.</td>
</tr>
<tr>
<td>CodePage=number</td>
<td>Multibyte characters are translated into Unicode based on this number. This option only applies to Windows Mobile devices.</td>
</tr>
</tbody>
</table>

See also
- “-d dblsn option” on page 54
- “-a dblsn option” on page 54

**MobiLink Listener options for Windows devices**

The following options can be used to configure the MobiLink Listener:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ { variable</td>
<td>filename }</td>
</tr>
<tr>
<td>-a value</td>
<td>Specifies a single library option for a listening library. See “-a dblsn option” on page 54.</td>
</tr>
<tr>
<td>-d filename</td>
<td>Specifies a listening library. See “-d dblsn option” on page 54.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>-e device-name</td>
<td>Specifies the device name. See “-e dblsn option” on page 55.</td>
</tr>
<tr>
<td>-f string</td>
<td>Specifies extra information about the device. See “-f dblsn option” on page 55.</td>
</tr>
<tr>
<td>-gi seconds</td>
<td>Specifies the IP tracker polling interval. See “-gi dblsn option” on page 56.</td>
</tr>
<tr>
<td>-i seconds</td>
<td>Specifies the polling interval for SMTP connections. See “-i dblsn option” on page 56.</td>
</tr>
<tr>
<td>-l &quot;keyword=value;...&quot;</td>
<td>Defines and creates a message handler. See “-l dblsn option” on page 56.</td>
</tr>
<tr>
<td>-ls</td>
<td>Enables SMS listening. Valid for Windows Mobile only. See “-ls dblsn option” on page 57.</td>
</tr>
<tr>
<td>-lu</td>
<td>Enables UDP listening. See “-lu dblsn option” on page 57.</td>
</tr>
<tr>
<td>-m</td>
<td>Turns on message logging. See “-m dblsn option” on page 57.</td>
</tr>
<tr>
<td>-ni</td>
<td>Disables IP tracking. See “-ni dblsn option” on page 58.</td>
</tr>
<tr>
<td>-o prefix</td>
<td>Logs output to a file. See “-o dblsn option” on page 58.</td>
</tr>
<tr>
<td>-os bytes</td>
<td>Specifies the maximum size of the log file. See “-os dblsn option” on page 58.</td>
</tr>
<tr>
<td>-ot filename</td>
<td>Truncates a file, then logs output to that file. See “-ot dblsn option” on page 59.</td>
</tr>
<tr>
<td>-p</td>
<td>Allows the device to shut down automatically when idle. See “-p dblsn option” on page 59.</td>
</tr>
<tr>
<td>-pc { +</td>
<td>- }</td>
</tr>
<tr>
<td>-q</td>
<td>Runs the MobiLink Listener in quiet mode. See “-q dblsn option” on page 60.</td>
</tr>
<tr>
<td>-qi</td>
<td>Prevents the dblsn icon and messages window from appearing. See “-qi dblsn option” on page 60.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>-r filename</code></td>
<td>Identifies a remote database involved in the responding action of a message filter. See “-r dblsn option” on page 60.</td>
</tr>
<tr>
<td><code>-sv script-version</code></td>
<td>Specifies the script version used for authentication. See “-sv dblsn option” on page 61.</td>
</tr>
<tr>
<td>`-t {+</td>
<td>- } name`</td>
</tr>
<tr>
<td><code>-ts session-name(session-option=[option-value;...])</code></td>
<td>Sets up a MobiLink Listener tracing session. See “-ts dblsn option” on page 61.</td>
</tr>
<tr>
<td><code>-u username</code></td>
<td>Specifies a MobiLink user name. See “-u dblsn option” on page 63.</td>
</tr>
<tr>
<td>`-v { 0</td>
<td>1</td>
</tr>
<tr>
<td><code>-w password</code></td>
<td>Specifies a MobiLink password. See “-w dblsn option” on page 64.</td>
</tr>
<tr>
<td>`-x { http</td>
<td>https</td>
</tr>
<tr>
<td><code>-y newpassword</code></td>
<td>Specifies a new MobiLink password. See “-y dblsn option” on page 64.</td>
</tr>
</tbody>
</table>

@data dblsn option
Applies MobiLink Listener options from the specified environment variable or text file.

Syntax

dblsn @{ variable | filename } ...

Remarks
By default, dblsn.txt is the argument file when the MobiLink Listener is run without parameters.

If a file and an environment variable with the same name exist, the environment variable is used.

Use the File Hiding utility to obfuscate passwords and other sensitive information in the text file.

See also

- “Configuration files” [SQL Anywhere Server - Database Administration]
- “File Hiding utility (dbfhide)” [SQL Anywhere Server - Database Administration]
Example

A sample text file is located at %SQLANYSAMP16%\MobiLink\SIS_SimpleListener\dblsn.txt.

The following example stores command line options in a `dblsnoptions` environment variable:

```
dblsn @dblsnoptions
```

The following example stores command line options in `mydblsn.txt`, a fully qualified text file:

```
dblsn @mydblsn.txt
```

-a `dblsn` option

Specifies a single library option for a listening library.

Syntax

```
dblsn -a value ...
```

Remarks

By default, the MobiLink Listener uses `lsn_udp16.dll` if a library is not specified. Use the `-d` option to specify alternative or additional libraries.

Use the `?` value to view all available library options.

Use the -a option multiple times to set additional library options.

See also

- “Listening libraries for Windows devices” on page 50
- “-d `dblsn` option” on page 54

Example

The following example specifies the port option and declares the `ShowSenderPort` option in the `lsn_udp16.dll` listening library:

```
dblsn -d lsn_udp16.dll -a port=1234 -a ShowSenderPort
```

The following example specifies the port option for two different libraries:

```
dblsn -d lsn_udp16.dll -a port=1234 -d maac750.dll -a port=2345
```

The following example displays all available library options in the default library:

```
dblsn -a ?
```

-d `dblsn` option

Specifies a listening library.
Syntax

dblsn -d filename ...

Remarks

By default, the MobiLink Listener uses the lsn_udp16.dll listening library.

Use the -d option multiple times to enable multi-channel listening, which enables listening on multiple media.

See also

● “Listening libraries for Windows devices” on page 50

Example

The following example specifies the maac750.dll listening library:

dblsn -d maac750.dll

-e dblsn option

Specifies the device name.

Syntax

   dblsn -e device-name ...

Remarks

By default, the device name is automatically generated by the operating system.

When connecting to the MobiLink server, make sure that all device names are unique.

The device name should be restricted to the following:

- alphanumeric characters
- period
- colon
- minus sign
- plus sign
- underscore

The device name can be found in the MobiLink Listener window.

-f dblsn option

Specifies extra information about the device.

Syntax

   dblsn -f string ...
Remarks
By default, this information is the version number of the operating system running on the device.

-gi dblsn option
Specifies the IP tracker polling interval.

Syntax
dblsn -gi number ...

Remarks
By default, the IP tracker polls every 60 seconds.

-i dblsn option
Specifies the polling interval for SMTP connections.

Syntax
dblsn -i number ...

Remarks
The -i option specifies the frequency at which the MobiLink Listener checks for messages.
For SMTP connections, the default is 30 seconds. For UDP connections, the MobiLink Listener connects immediately.
The -i option can be used once for every listening library that is specified with the -d option.

See also
- “-d dblsn option” on page 54

Example
The following example specifies the polling intervals for two different libraries:

dblsn -d lsn_udp16.dll -i 60 -d maac750.dll -i 45

-l dblsn option
Defines and creates a message handler.

Syntax
dblsn -l "keyword=value;..." ...

Remarks
For a list of acceptable keywords, see “MobiLink Listener keywords for Windows devices” on page 65.
Use the -l option multiple times to define additional message handlers for push notifications. Message handlers are processed in the order they are specified.

See also
- “Message handlers” on page 12

**-ls dblsn option**

Enables SMS listening. SMS listeners are unsecured and should be avoided. See “Secure Listener deployment” on page 50.

**Syntax**

```
 dblsn -ls ...
```

**Remarks**

For a list of acceptable keywords, see “MobiLink Listener keywords for Windows devices” on page 65.

SMS listening is disabled by default.

See also
- “-x dblsn option” on page 64

**-lu dblsn option**

Enables UDP listening. UDP listeners are unsecured and should be avoided. See “Secure Listener deployment” on page 50.

**Syntax**

```
 dblsn -lu ...
```

**Remarks**

For a list of acceptable keywords, see “MobiLink Listener keywords for Windows devices” on page 65.

UDP listening is disabled by default.

See also
- “-x dblsn option” on page 64

**-m dblsn option**

Turns on message logging.

**Syntax**

```
 dblsn -m ...
```
Remarks
By default, message logging is turned off.

-ni dblsn option
Disables IP tracking.

Syntax
dblsn -ni ...

Remarks
By default, IP tracking is enabled.
This option does not stop delivery confirmation.
The -ni option disables UDP address tracking when used with the -x option. This feature is useful if you want device tracking to exclude UDP address updates.

See also
- “-x dblsn option” on page 64

-o dblsn option
Logs output to a file.

Syntax
dblsn -o filename ...

Remarks
By default, output is logged to the MobiLink Listener window.

See also
- “-ot dblsn option” on page 59

-os dblsn option
Specifies the maximum size of the log file.

Syntax
dblsn -os bytes ...

Remarks
By default, there is no maximum size limit. The minimum size limit is 10000.
**-ot dblsn option**

Truncates a file, then logs output to that file.

**Syntax**

```bash
dblsn -ot filename ...
```

**Remarks**

The file contents are deleted before output is logged.

**See also**

- “-o dblsn option” on page 58

**-p dblsn option**

Allows the device to shut down automatically when idle.

**Syntax**

```bash
dblsn -p ...
```

**Remarks**

By default, the MobiLink Listener prevents the device from shutting down.

This option applies to Windows Mobile devices only.

**-pc dblsn option**

**Syntax**

Enables or disables persistent connections.

```bash
dblsn -pc { + | - } ...
```

**Remarks**

By default, persistent connections are enabled. The - flag disables persistent connections; the + flag enables them.

Disabling persistent connections prevents the MobiLink Listener from receiving push notifications, but allows short-lived persistent connections for device tracking and confirmation.

If a persistent connection is broken, the MobiLink Listener continuously attempts to reconnect.

**Example**

The following example disables persistent connections:

```bash
dblsn -pc-
```
-q dblsn option

Runs the MobiLink Listener in quiet mode.

Syntax

dblsn -q ...

Remarks

The -q option minimizes the MobiLink Listener window. By default, the MobiLink Listener window is displayed.

-qi dblsn option

Prevents the dblsn icon and messages window from appearing.

Syntax

dblsn -qi ...

Remarks

This option leaves no visual indication that dblsn is running, other than possible startup error windows. You can use the -o log files to diagnose errors.

See also

- “-o dblsn option” on page 58

-r dblsn option

Identifies a remote database involved in the responding action of a message filter.

Syntax

dblsn -r filename ...

Remarks

The filename must contain the full path of an RID file. This file is automatically created by dbmlsync after the first synchronization. It uses the same location and name as the database file. For UltraLite databases, filename should be the same as the database name.

When applying the -r option, the $remote_id action variable can be used in message handlers to reference the remote ID in the RID file. By default, Remote IDs are GUIDs.

Use the -r option multiple times to identify multiple databases.

See also

- “Message filters” on page 13
- “MobiLink Listener action commands for Windows devices” on page 67
-sv dblsn option
Specifies the script version used for authentication.

Syntax
```
dblsn -sv script-version ...
```

Remarks
By default, the MobiLink Listener uses the ml_global server script version if it is defined.

-t dblsn option
Registers or unregisters the remote ID for a remote database.

Syntax
```
dblsn -t { + | - } name ...
```

Remarks
The + flag registers a remote ID; the - flag unregisters ID.

Registering allows the MobiLink Listener to address push notifications by referencing that remote ID.

When device tracking information is uploaded successfully, registered IDs are retained in the ml_listening system table on the server. You only need to register the ID once.

Use the -t option multiple times to register or unregister multiple IDs. Registering multiple IDs is useful for addressing push notifications to multiple remote databases.

See also
- “MobiLink Listener action commands for Windows devices” on page 67

-ts dblsn option
Sets up a MobiLink Listener tracing session.

Syntax
```
dblsn -ts session-name(session-option=[option-value;...])
```

The session name must be logging.

<table>
<thead>
<tr>
<th>Session option</th>
<th>Option value</th>
</tr>
</thead>
<tbody>
<tr>
<td>events</td>
<td>Comma separated list of system trace events. The supported events are Info, Warning, and Error.</td>
</tr>
</tbody>
</table>
Session option | Option value
---|---
targets | target-type(target-option=value[;...]) where target-type can only be file.

The target options are specified as name-value pairs. The target file can have the following options:

<table>
<thead>
<tr>
<th>Target option name</th>
<th>Expected value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>filename_prefix</td>
<td>String</td>
<td>An ETD file name prefix with or without a path. All ETD files have the extension .etd. This parameter is required.</td>
</tr>
<tr>
<td>max_size</td>
<td>Integer</td>
<td>The maximum size of the file in bytes. The default is 0, which means there is no limit on the file size and it grows as long as disk space is available. Once the specified size is reached, a new file is started.</td>
</tr>
<tr>
<td>num_files</td>
<td>Integer</td>
<td>The number of files where event tracing information is written, and it is used only if max_size is set. If all the files reach the maximum specified size, the MobiLink Listener starts overwriting the oldest file.</td>
</tr>
<tr>
<td>flush_on_write</td>
<td>yes, true, no, false</td>
<td>A value that controls whether disk buffers are flushed for each event that is logged. The values yes, true, no, and false are accepted. The default is false. When this parameter is turned on, the performance of the MobiLink Listener may be reduced if many trace events are being logged.</td>
</tr>
<tr>
<td>compressed</td>
<td>yes, true, no, false</td>
<td>A value that controls compression of the ETD file to conserve disk space. The default is false.</td>
</tr>
</tbody>
</table>

**Remarks**

All information specified after the `-ts logging` portion of the option must be specified without any spaces.

**See also**

- “Event Trace Data (ETD) File Management utility (dbmanageetd)” [SQL Anywhere Server - Database Administration]

**Example**

Following is an example of the -ts option:

```bash
-ts
logging{events=Info,warning,Error;targets=file{filename_prefix=mls_etd;max_size=10000000;num_files=10;flush_on_write=true}}
```
-u dblsn option

Specifies a MobiLink user name for the MobiLink Listener.

Syntax

dblsn -u username ...

Remarks

By default, the user name is device-name-dblsn, where device-name is the name of your device. You can specify a device name using the -e option.

The MobiLink Listener uses the user name to connect to the MobiLink server for device tracking, confirmations, and persistent connections.

The user name must be a unique MobiLink user name registered with the MobiLink server. The name must exist in the ml_user system table on the consolidated database.

See also

● “-e dblsn option” on page 55
● “-w dblsn option” on page 64
● “MobiLink user creation and registration” [MobiLink - Client Administration]

-v dblsn option

Specifies the verbosity level for the message log.

Syntax

dblsn -v { 0 | 1 | 2 | 3 } ...

Remarks

By default, the verbosity level is set to 0.

The following table summarizes the possible verbosity level values.

<table>
<thead>
<tr>
<th>Verbosity level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Verbosity is turned off.</td>
</tr>
<tr>
<td>1</td>
<td>Displays listening library messages, basic action tracing steps, and command line options.</td>
</tr>
<tr>
<td>2</td>
<td>Displays level 1 verbosity messages, and detailed action tracing steps.</td>
</tr>
<tr>
<td>3</td>
<td>Displays level 2 verbosity messages, polling states, and listening states.</td>
</tr>
</tbody>
</table>

You must use the -m option to output push notifications to the message log.
See also
- “-m dblsn option” on page 57
- “How to log database server messages to a file” [SQL Anywhere Server - Database Administration]

-w dblsn option

Specifies a MobiLink password.

Syntax
dblsn -w password ...

Remarks
Passwords must be registered with the MobiLink server under the associated MobiLink user name.

The MobiLink Listener uses the password to connect to the MobiLink server for device tracking, confirmations, and persistent connections.

See also
- “-u dblsn option” on page 63

-x dblsn option

Specifies the network protocol, and the MobiLink server protocol options.

Syntax
dblsn -x { http | https | tcpip } [ (protocol-option=value;...) ] ...

Remarks
A connection to the MobiLink server is required so the MobiLink Listener can send device tracking information and delivery confirmation to the consolidated database. Use the host protocol option to specify the location of the MobiLink server. See “host” [MobiLink - Client Administration].

The -x option allows the device to update the consolidated database if the server address changes.

See also
- “MobiLink client network protocol options” [MobiLink - Client Administration]

-y dblsn option

Specifies a new MobiLink password.

Syntax
dblsn -y newpassword ...
Remarks
The -y option is not applicable if your authentication system does not allow remote devices to change their passwords.

**MobiLink Listener keywords for Windows devices**

The following keywords can be used to configure message handlers created with the dblsn -l option. For more information about using MobiLink Listener keywords, see “-l dblsn option” on page 56.

**Filter keywords**
Use the following keywords to filter messages in a push notification:

<table>
<thead>
<tr>
<th>Keyword syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>subject= subject-string</td>
<td>Filters a message if the subject is textually equivalent to subject-string.</td>
</tr>
<tr>
<td>content= content-string</td>
<td>Filters a message if the content is textually equivalent to content-string.</td>
</tr>
<tr>
<td>message= message-string</td>
<td>Filters a message if the entire message is textually equivalent to message-string.</td>
</tr>
<tr>
<td>message_start= message-string</td>
<td>Filters a message if it begins with message-string.</td>
</tr>
<tr>
<td>sender= sender-string</td>
<td>Filters a message if it is sent by sender-string.</td>
</tr>
</tbody>
</table>

**Action keywords**
Use the following keywords to initiate an action when a filter condition is met:

<table>
<thead>
<tr>
<th>Keyword syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>action= command</td>
<td>Specifies an action command. See “MobiLink Listener action commands for Windows devices” on page 67.</td>
</tr>
<tr>
<td>altaction= command</td>
<td>Specifies an alternative action command that is initiated when the action command fails. See “MobiLink Listener action commands for Windows devices” on page 67.</td>
</tr>
</tbody>
</table>

**Polling options**
Use the following options to configure a light weight poller:
<table>
<thead>
<tr>
<th>Keyword syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>poll_connect={ http</td>
<td>https</td>
</tr>
<tr>
<td>poll_notifier=Notifier-string</td>
<td>Specifies the name of the Notifier that handles push requests. Required.</td>
</tr>
<tr>
<td>poll_key=key-string</td>
<td>Specifies the name of the MobiLink Listener to identify itself to the Notifier. This value must be unique. Required.</td>
</tr>
<tr>
<td>poll_every=seconds-number</td>
<td>Specifies how often the MobiLink Listener should poll the server. The interval is measured in seconds. The default value is auto-retrieved from the MobiLink server.</td>
</tr>
</tbody>
</table>

Options

The following can be used to configure message handler behavior:

<table>
<thead>
<tr>
<th>Keyword syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>continue=[ yes</td>
<td>no ]</td>
</tr>
<tr>
<td>confirm_action=[ yes</td>
<td>no ]</td>
</tr>
</tbody>
</table>
### confirm_delivery=[yes | no]

Specifies whether the filter should confirm qualified message delivery. The default value is `yes`, so delivery confirmation is sent after the first filter accepts the message.

Delivery can only be confirmed if the message requires confirmation, and if the filter accepts the message. A message requires confirmation if the specified gateway has its `confirm_delivery` keyword value set to `yes`. A `no` value can be used when multiple filters accept the same message to give you finer control over which filter should confirm the delivery. For information about handling delivery confirmation on the server, see “confirmation_handler event” on page 38.

### maydial=[yes | no]

Specifies whether the action has permission to dial the modem. The default value is `yes`. A `no` value causes the MobiLink Listener to release the modem before the action.

---

**See also**
- “Message handlers” on page 12
- “MobiLink Listener action commands for Windows devices” on page 67

---

## MobiLink Listener action commands for Windows devices

An action is specified when you configure a new message handler. When a filter condition is met, an action is initiated. If the action fails, an alternative action is initiated. Actions are defined using the `action` keyword; alternative actions are defined using the `altaction` keyword.

Following is a list of action commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>START</strong> <code>program arglist</code></td>
<td>Initiates a program while the MobiLink Listener runs in the background. See “START action command” on page 68.</td>
</tr>
<tr>
<td><strong>RUN</strong> <code>program arglist</code></td>
<td>Pauses the MobiLink Listener to run a program. See “RUN action command” on page 68.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>POST windowmessage</td>
<td>Posts a window message to a window class. See “POST action command” on page 69.</td>
</tr>
<tr>
<td>SOCKET port=windowname[.host=hostname] [:sendText=text][:recvText=text[:timeout=seconds]]</td>
<td>Sends a message to an application using a TCP/IP connection. See “SOCKET action command” on page 70.</td>
</tr>
<tr>
<td>DBLSN FULL SHUTDOWN</td>
<td>Forces the MobiLink Listener to shutdown. See “DBLSN FULL SHUTDOWN action command” on page 70.</td>
</tr>
</tbody>
</table>

You can only specify one action per action or altaction keyword. If you want an action to perform multiple tasks, create a batch file that contains multiple commands and run the file using the RUN action command.

See also

- “Initiation of actions” on page 14
- “MobiLink Listener keywords for Windows devices” on page 65

### START action command

Initiates a program while the MobiLink Listener runs in the background.

**Syntax**

```
action='START program arglist'
```

**Remarks**

When you start a program, the MobiLink Listener continues listening for more push notifications.

The MobiLink Listener does not wait for the program to finish, so it can only determine if an action command has failed, or if it cannot start the specified program.

**Example**

The following example starts dbmlsync with some command line options, parts of which are obtained from messages using the $content action variable:

```
dblsn -l "action='start dbmlsync.exe @dbmlsync.txt -n $content -wc dbmlsync_$content -e sch=INFINITE';"`
```

### RUN action command

Pauses the MobiLink Listener to run a program.
Syntax

```
action='RUN program arglist'
```

Remarks

The MobiLink Listener waits for the program to finish, then resumes listening.

When running a program, the MobiLink Listener determines if the program has failed, if the MobiLink Listener cannot start the program or if the program returns a non-zero return code.

Example

The following example runs dbmlsync with some command line options, parts of which are obtained from the message using the $content action variable:

```
dblsn -l "action='run dbmlsync.exe @dbmlsync.txt -n $content';"  
```

**POST action command**

Posts a window message to a window class.

Syntax

```
action='POST windowmessage | id to windowclass | windowtitle'
```

Remarks

The POST command can be used to signal applications that use window messages.

You can identify the window message by message contents, or by the window message ID, if one exists.

You can identify the window class by its class name or the window title. If you identify by name, you can use the -wc dbmlsync option to specify the window class name. If you identify the window class by the window title, you can only reference it by the top level window.

If your window message or window class name contains non-alphanumeric characters, such as spaces or punctuation marks, encapsulate the text in single quotes ('). The escape character is also a single quote, so if your window message or window class name contains single quotes, reference the quote using two single quotes (").

The following are valid for POST:

- **Post by decimal id**  For example, `post 999 to <wc|wt>`
- **Post by hex id**  For example, `post 0x3E7 to <wc|wt>`
- **Post by registered message name**  For example, `post myRegisteredMsgName to <wc|wt>`

Example

To demonstrate the use of windows and messages containing single quotes, the following example posts mike's_message window message to the mike's_class window class:
The following example posts a window message, dbas_synchronize, to a dbmlsync instance registered with the dbmlsync_FullSync class name:

```
dblsn -l "action='post dbas_synchronize to dbmlsync_FullSync';"
```

See also
- “-wc dbmlsync option” [MobiLink - Client Administration]

**SOCKET action command**

Sends a message to an application using a TCP/IP connection.

**Syntax**

```
action='SOCKET port=windowname[;host=hostname][;sendText=text][;recvText=text][;timeout=seconds]'
```

**Remarks**

The SOCKET command is used for passing dynamic information to a running application, and for integrating messages into Java and Visual Basic applications. Both languages do not support custom window messaging, and eMbedded Visual Basic does not support command line parameters.

To connect to a socket, you must specify the port and the host. Use sendText to input your message. Use recvText to display a message when confirming that sendText is successfully received by the application. When using recvText, you can specify a timeout limit. The action fails if the MobiLink Listener cannot connect, send acknowledgements, or receive acknowledgements during the timeout limit.

**Example**

The following example forwards the string in $sender=$message to a local application that is listening on port 12345. The MobiLink Listener expects the application to send "beeperAck" as an acknowledgement within 5 seconds.

```
dblsn -l "action='socket port=12345; sendText=$sender=$message; recvText=beeperAck; timeout=5';"
```

**DBLSN FULL SHUTDOWN action command**

Forces the MobiLink Listener to shutdown.

**Syntax**

```
action='DBLSN FULL SHUTDOWN'
```
Remarks
After shutdown, the MobiLink Listener stops handling push notifications and stops synchronizing device tracking information. You must restart the MobiLink Listener to continue with server-initiated synchronization.

MobiLink Listener action variables for Windows devices

The following action variables can be used in an action or a filter. The value is substituted into the action variable before initiating the message handler.

Action variables start with a dollar sign ( $ ). The escape character is also a dollar sign, so use two dollar signs ( $$ ) to specify a single dollar sign as plain text.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$subject</td>
<td>The subject of a message.</td>
</tr>
<tr>
<td>$content</td>
<td>The content of a message.</td>
</tr>
<tr>
<td>$message</td>
<td>An entire message, including subject, content, and sender.</td>
</tr>
<tr>
<td>$message_start</td>
<td>The beginning portion of a message, as specified by the message_start filter keyword. This variable is only available if you have specified the message_start filter keyword. See “MobiLink Listener keywords for Windows devices” on page 65.</td>
</tr>
<tr>
<td>$message_end</td>
<td>The portion of a message, excluded from the message_start filter keyword. This variable is only available if you have specified the message_start filter keyword. See “MobiLink Listener keywords for Windows devices” on page 65.</td>
</tr>
<tr>
<td>$ml_connect</td>
<td>The MobiLink network protocol options as specified by the dblsn -x option. The default is an empty string. See “-x dblsn option” on page 64.</td>
</tr>
<tr>
<td>$ml_user</td>
<td>The MobiLink user name as specified by the dblsn -u option. The default name is device-name-dblsn.</td>
</tr>
<tr>
<td>$ml_password</td>
<td>The MobiLink password as specified by dblsn -w option, or the new Mobi-Link password if -y is used.</td>
</tr>
<tr>
<td>$priority</td>
<td>The meaning of this variable is carrier library-dependent.</td>
</tr>
<tr>
<td>$request_id</td>
<td>The request ID that was specified in a push request. See “Push requests” on page 5.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$remote_id</td>
<td>The remote ID. This variable can only be used when the <code>dblsn -r</code> option is specified. See “Remote ID as a filter” on page 16.</td>
</tr>
<tr>
<td>$sender</td>
<td>The sender of a message.</td>
</tr>
<tr>
<td>$type</td>
<td>The meaning of this variable is carrier library-dependent.</td>
</tr>
<tr>
<td>$year</td>
<td>The meaning of this variable is carrier library-dependent.</td>
</tr>
<tr>
<td>$month</td>
<td>The meaning of this variable is carrier library-dependent. Values can be from 1-12.</td>
</tr>
<tr>
<td>$day</td>
<td>The meaning of this variable is carrier library-dependent. Values can be from 1-31.</td>
</tr>
<tr>
<td>$hour</td>
<td>The meaning of this variable is carrier library-dependent. Values can be from 0-23.</td>
</tr>
<tr>
<td>$minute</td>
<td>The meaning of this variable is carrier library-dependent. Values can be from 0-59.</td>
</tr>
<tr>
<td>$second</td>
<td>The meaning of this variable is carrier library-dependent. Values can be from 0-59.</td>
</tr>
<tr>
<td>$best_adapter_mac</td>
<td>The MAC address of the best NIC for reaching the MobiLink server that is specified by the <code>dblsn -x</code> option. If the best route does not go through a NIC, the value is an empty string.</td>
</tr>
<tr>
<td>$best_adapter_name</td>
<td>The adapter name of the best NIC for reaching the MobiLink server that is specified by the <code>dblsn -x</code> option. If the best route does not go through a NIC, the value is an empty string.</td>
</tr>
<tr>
<td>$best_ip</td>
<td>The IP address of the best IP interface for reaching the MobiLink server that is specified by the <code>dblsn -x</code> option. If that server is unreachable, the value is 0.0.0.0.</td>
</tr>
<tr>
<td>$best_network_name</td>
<td>The RAS or dial-up profile name of the best profile for reaching the MobiLink server that is specified by the <code>dblsn -x</code> option. If the best route does not go through a RAS/dial-up connection, the value is an empty string.</td>
</tr>
<tr>
<td>$adapters</td>
<td>A list of active network adapter names, each separated by a vertical bar (</td>
</tr>
<tr>
<td>$network_names</td>
<td>A list of connected RAS entry names, each separated by a vertical bar (</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$poll_connect</td>
<td>The MobiLink network protocol options as specified by the poll_connect polling keyword. The default is an empty string. See “MobiLink Listener keywords for Windows devices” on page 65.</td>
</tr>
<tr>
<td>$poll_notifier</td>
<td>The name of the Notifier as specified by the poll_notifier polling keyword. See “MobiLink Listener keywords for Windows devices” on page 65.</td>
</tr>
<tr>
<td>$poll_key</td>
<td>The poll key as specified by the poll_key polling keyword. See “MobiLink Listener keywords for Windows devices” on page 65.</td>
</tr>
<tr>
<td>$poll_every</td>
<td>The polling frequency as specified by the poll_every polling keyword. See “MobiLink Listener keywords for Windows devices” on page 65.</td>
</tr>
</tbody>
</table>

See also

- “-l dblsn option” on page 56
- “MobiLink Listener keywords for Windows devices” on page 65
- “MobiLink Listener action commands for Windows devices” on page 67

Example

The following examples uses the $message_end action variable to determine which publication to synchronize:

```
dblsn -l "message_start=start-of-message;action='run dbmlsync.exe -c ... -n $message_end'"
```
Light weight polling API

The light weight polling API is a programming interface that you can integrate into your device application. It contains the methods needed to poll a server.

Required files
All directories are relative to %SQLANY16%. The following is a list of files required to compile the light weight polling API:

<table>
<thead>
<tr>
<th>File name or location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bin32\mllplib16.dll</td>
<td>Light weight polling API runtime dynamic library.</td>
</tr>
<tr>
<td>SDK\Lib\x86\mllplib16.lib and SDK\Lib\x64\mllplib16.lib</td>
<td>Light weight polling API runtime import library.</td>
</tr>
<tr>
<td>SDK\Include\mllplib.h</td>
<td>Light weight polling API header file.</td>
</tr>
</tbody>
</table>

A SIS_CarDealer_LP_API sample application written in C is supplied in %SQLANYSAMP16%MobiLink\SIS_CarDealer_LP_API.

API members

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“MLLightPoller class”</td>
<td>Represents a light weight poller object.</td>
</tr>
<tr>
<td>“MLLPCreatePoller method”</td>
<td>Creates an instance of an MLLightPoller.</td>
</tr>
<tr>
<td>“MLLPDestroyPoller method”</td>
<td>Destroys an instance of an MLLightPoller.</td>
</tr>
</tbody>
</table>

MLLightPoller class

Represents a light weight poller object.

Syntax

```java
public class MLLightPoller
```

Members

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Poll method”</td>
<td>Polls the server, prompting a Notifier to check a cache for push requests.</td>
</tr>
<tr>
<td>“SetConnectInfo method”</td>
<td>Sets up a MobiLink client stream type, and network protocol options.</td>
</tr>
</tbody>
</table>
**Name** | **Description**
--- | ---
“auth_status enumeration” | Specifies possible authentication status codes.
“return_code enumeration” | Specifies possible return codes.

**Example**
```c
MLLightPoller * poller = MLLCreatePoller();
```

## Poll method
Polls the server, prompting a Notifier to check a cache for push requests.

### Syntax
```c
public virtual return_code MLLightPoller::Poll(
    const char * notifier,
    const char * key,
    char * subject = 0,
    size_t * subjectSize = 0,
    char * content = 0,
    size_t * contentSize = 0
)
```

### Parameters
- **notifier**  The name of the Notifier.
- **key**  The name of the poll key identifying the MobiLink Listener.
- **subject**  The buffer to receive a message subject. (null-terminated)
- **subjectSize**  IN: The size of the subject buffer.
  OUT: The size of the received subject, including a null-terminator, where zero indicates a null subject.
- **content**  The buffer to receive message content. (null-terminated)
- **contentSize**  IN: The size of the content buffer.
  OUT: The size of the received content, including a null-terminator, where zero indicates null content.

### Returns
One of the codes listed in the return_code enumeration. See “return_code enumeration” on page 78.

### Remarks
The MobiLink Listener connects to the Notifier, then disconnects after the Notifier checks its cache for a push notification targeted for the given poll key.
SetConnectInfo method

Sets up a MobiLink client stream type, and network protocol options.

Syntax

```csharp
public virtual return_code MLLightPoller::SetConnectInfo(
    const char * streamName,
    const char * streamParams
);
```

Parameters

- **streamName**  The network protocol to use. Acceptable values are: tcpip, http, https, or tls.
- **streamParams** A protocol options string, formatted in a semicolon delimited list. For a complete list of options, see “MobiLink client network protocol options” [MobiLink - Client Administration].

Returns

One of the codes listed in the return_code enumeration. See “return_code enumeration” on page 78.

Example

```csharp
poller_ret = poller->SetConnectInfo("http", "host=localhost;port=80;")
```

auth_status enumeration

Specifies possible authentication status codes.

Syntax

```csharp
public typedef enum MLLightPoller::auth_status;
```

Members

<table>
<thead>
<tr>
<th>Member name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTH_EXPIRED</td>
<td>Authentication has expired.</td>
</tr>
<tr>
<td>AUTH_IN_USE</td>
<td>The user name is already authenticated.</td>
</tr>
<tr>
<td>AUTH_INVALID</td>
<td>Authentication is invalid.</td>
</tr>
<tr>
<td>AUTH_UNKNOWN</td>
<td>Authentication is unknown.</td>
</tr>
<tr>
<td>AUTH_VALID</td>
<td>Authentication is valid.</td>
</tr>
<tr>
<td>AUTH_VALID_BUT_EXPIRES_SOON</td>
<td>Authentication is valid but expires soon.</td>
</tr>
</tbody>
</table>
**return_code enumeration**

Specifies possible return codes.

**Syntax**

```java
public typedef enum MLLightPoller::return_code;
```

**Members**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTH_FAILED</td>
<td>Failed to authenticate the connection to the MobiLink server.</td>
</tr>
<tr>
<td>BAD_STREAM_NAME</td>
<td>Unrecognizable stream name.</td>
</tr>
<tr>
<td>BAD_STREAM_PARAM</td>
<td>Failed parsing a stream parameter.</td>
</tr>
<tr>
<td>COMMUNICATION_ERROR</td>
<td>Failed due to a communication error.</td>
</tr>
<tr>
<td>CONNECT_FAILED</td>
<td>Failed to connect to the MobiLink server.</td>
</tr>
<tr>
<td>CONTENT_OVERFLOW</td>
<td>The content buffer is too small.</td>
</tr>
<tr>
<td>KEY_NOT_FOUND</td>
<td>There is no push notification for the specified key from the specified Notifier.</td>
</tr>
<tr>
<td>NYI</td>
<td>For internal use only.</td>
</tr>
<tr>
<td>OK</td>
<td>Method ran successfully.</td>
</tr>
<tr>
<td>SUBJECT_OVERFLOW</td>
<td>The subject buffer is too small.</td>
</tr>
</tbody>
</table>

**MLLPCreatePoller method**

Creates an instance of an MLLightPoller.

**Syntax**

```java
extern MLLightPoller * MLLPCreatePoller();
```

**Returns**

A new MLLightPoller object.

**See also**

- “MLLPDestroyPoller method” on page 79
Example

```c
poller = MLLPCreatePoller();
```

**MLLPDestroyPoller method**

Destroys an instance of an MLLightPoller.

**Syntax**

```c
extern void MLLPDestoryPoller(
    MLLightPoller * poller
)
```

**Parameters**

- **poller**  The MLLightPoller to destroy.

**Remarks**

This method accepts null MLLightPoller objects.

**See also**

- “MLPCreatePoller method” on page 78

**Example**

```c
MLLPDestroyPoller(poller);
```
Server-initiated synchronization system procedures

Server-initiated synchronization system procedures add and delete rows in MobiLink system tables.

**Note**
These system procedures are used for device tracking. If you use remote devices that support automatic device tracking, you do not need to use these system procedures. If you use remote devices that do not support automatic device tracking, you can configure manual device tracking using these system procedures.

See also
- “Device tracking gateways” on page 19
- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20
- “MobiLink server system tables” [MobiLink - Server Administration]
- “MobiLink server system procedures” [MobiLink - Server Administration]

**ml_delete_device system procedure**

Use this system procedure to delete all information about a remote device when you are manually setting up device tracking.

**Parameters**

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@device</td>
<td>VARCHAR(255). Device name.</td>
</tr>
</tbody>
</table>

**Remarks**
This function is useful only if you are manually setting up device tracking.

See also
- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20

**Example**
Delete a device record and all associated records that reference this device record:

```sql
CALL ml_delete_device('myOldDevice');
```

**ml_delete_device_address system procedure**

Use this system procedure to delete a device address when you are manually setting up device tracking.
ml_delete_device_address system procedure

Use this system procedure to delete mappings between a MobiLink user and remote devices when you are manually setting up device tracking.

Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@device</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>2</td>
<td>@medium</td>
<td>VARCHAR(255)</td>
</tr>
</tbody>
</table>

Remarks

This system procedure is useful only if you are manually setting up device tracking.

See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20

Example

Delete an address record:

```sql
CALL ml_delete_device_address('myWindowsMobile', 'ROGERS AT&T');
```

ml_delete_listening system procedure

Use this system procedure to delete mappings between a MobiLink user and remote devices when you are manually setting up device tracking.

Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@name</td>
<td>VARCHAR(128)</td>
</tr>
</tbody>
</table>

Remarks

This system procedure is useful only if you are manually setting up device tracking.

See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20

Example

Delete a recipient record:

```sql
CALL ml_delete_listening('myULDB');
```

ml_set_device system procedure

Use this system procedure to add or alter information about remote devices when you are manually setting up device tracking. It adds or updates a row in the ml_device table.
Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@device</td>
<td>VARCHAR(255). User-defined unique device name.</td>
</tr>
<tr>
<td>2</td>
<td>@listener_version</td>
<td>VARCHAR(128). Optional remarks on MobiLink Listener version.</td>
</tr>
<tr>
<td>3</td>
<td>@listener_protocol</td>
<td>INTEGER. Use 0 for version 9.0.0 or 2 for post-9.0.0 MobiLink Listeners for Windows devices.</td>
</tr>
<tr>
<td>4</td>
<td>@info</td>
<td>VARCHAR(255). Optional device information.</td>
</tr>
<tr>
<td>5</td>
<td>@ignore_tracking</td>
<td>VARCHAR(1). Set to y to ignore tracking and stop it from overwriting manually entered data.</td>
</tr>
<tr>
<td>6</td>
<td>@source</td>
<td>VARCHAR(255). Optional remarks on the source of this record.</td>
</tr>
</tbody>
</table>

Remarks

The system procedures ml_set_device, ml_set_device_address, and ml_set_listening are used to override automatic device tracking by changing information in the MobiLink system tables ml_device, ml_device_address, and ml_listening.

This system procedure is useful only if you are manually setting up device tracking.

See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20
- “ml_set_device_address system procedure” on page 83
- “ml_set_listening system procedure” on page 84

Example

For each device, add a device record:

```sql
CALL ml_set_device(
    'myWindowsMobile',
    'MobiLink Listeners for myWindowsMobile - 9.0.1',
    '1',
    'not used',
    'y',
    'manually entered by administrator' );
```

ml_set_device_address system procedure

Use this system procedure to add or alter information about remote device addresses when you are manually setting up device tracking. It adds or updates a row in the ml_device_address table.
### Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@device</td>
<td>VARCHAR(255). Existing device name.</td>
</tr>
<tr>
<td>2</td>
<td>@medium</td>
<td>VARCHAR(255). Network provider ID (must match a carrier's network_provider_id property).</td>
</tr>
<tr>
<td>3</td>
<td>@address</td>
<td>VARCHAR(255). Phone number of an SMS-capable device.</td>
</tr>
<tr>
<td>4</td>
<td>@active</td>
<td>VARCHAR(1). Set to $y$ to activate this record to be used for sending push notifications.</td>
</tr>
<tr>
<td>5</td>
<td>@ignore_tracking</td>
<td>VARCHAR(1). Set to $y$ to ignore tracking and stop it from overwriting manually entered data.</td>
</tr>
<tr>
<td>6</td>
<td>@source</td>
<td>VARCHAR(255). Optional remarks on the source of this record.</td>
</tr>
</tbody>
</table>

### Remarks

The system procedures `ml_set_device`, `ml_set_device_address`, and `ml_set_listening` are used to override automatic device tracking by changing information in the MobiLink system tables `ml_device`, `ml_device_address`, and `ml_listening`.

This system procedure is useful only if you are manually setting up device tracking.

### See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20
- “ml_set_device system procedure” on page 82
- “ml_set_listening system procedure” on page 84

### Example

For each device, add an address record for a device:

```sql
CALL ml_set_device_address(
   'myWindowsMobile',
   'ROGERS AT&T',
   '3211234567',
   'y',
   'y',
   'manually entered by administrator'
);
```

### ml_set_listening system procedure

Use this system procedure to add or alter mappings between MobiLink users and remote devices when you are manually setting up device tracking. It adds or updates a row in the `ml_listening` table.
Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@name</td>
<td>VARCHAR(128). MobiLink user name.</td>
</tr>
<tr>
<td>2</td>
<td>@device</td>
<td>VARCHAR(255). Existing device name.</td>
</tr>
<tr>
<td>3</td>
<td>@listening</td>
<td>VARCHAR(1). Set to y to activate this record to be used for DeviceTracker addressing.</td>
</tr>
<tr>
<td>4</td>
<td>@ignore_tracking</td>
<td>VARCHAR(1). Set to y to ignore tracking and stop it from overwriting manually entered data.</td>
</tr>
<tr>
<td>5</td>
<td>@source</td>
<td>VARCHAR(255). Optional remarks on the source of this record.</td>
</tr>
</tbody>
</table>

Remarks

The system procedures ml_set_device, ml_set_device_address, and ml_set_listening are used to override automatic device tracking by changing information in the MobiLink system tables ml_device, ml_device_address, and ml_listening.

This system procedure is useful only if you are manually setting up device tracking.

See also

- “Setting up device tracking for 9.0.0 MobiLink Listeners” on page 20
- “ml_set_device system procedure” on page 82
- “ml_set_device_address system procedure” on page 83

Example

For each remote database, add a recipient record for a device. This maps the device to the MobiLink user name.

```sql
CALL ml_set_listening(
  'myULDB',
  'myWindowsMobile',
  'y',
  'y',
  'manually entered by administrator'
);
```

ml_set_sis_sync_state system procedure

Use this system procedure to record the MobiLink synchronization state into the ml_sis_sync_state system table.
### Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@remote_id</td>
<td>VARCHAR(128)</td>
</tr>
<tr>
<td>2</td>
<td>@subscription_id</td>
<td>VARCHAR(128)</td>
</tr>
<tr>
<td>3</td>
<td>@publication_name</td>
<td>VARCHAR(128)</td>
</tr>
<tr>
<td>4</td>
<td>@user_name</td>
<td>VARCHAR(128)</td>
</tr>
<tr>
<td>5</td>
<td>@last_upload</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>6</td>
<td>@last_download</td>
<td>TIMESTAMP</td>
</tr>
</tbody>
</table>

### Remarks

Call the `ml_set_sis_sync_state` system procedure in the `publication_nonblocking_download_ack` event to allow users to create a request_cursor event that references the `ml_sis_sync_state` table.

### See also

- “`publication_nonblocking_download_ack` connection event” [MobiLink - Server Administration]

### Example

Specify a `publication_nonblocking_download_ack` event script with the following script to record the synchronization state:

```sql
CALL ml_set_sis_sync_state(
  {ml s.remote_id},
  NULL,
  {ml s.publication_name},
  {ml s.username},
  NULL,
  {ml s.last_publication_download}
);
```
Server-initiated synchronization advanced topics

The following sections provide information about advanced topics related to server-initiated synchronization.

Message syntax

The following message syntax applies to light weight polling (default), UDP gateways, and SYNC gateways:

\[ \text{message} = \text{[subject]}\text{content} \]

Messages sent using the SMTP gateway have one of the following syntax structures:

- \( \text{message} = \text{sender[subject]}\text{content} \)
- \( \text{message} = \text{sender(subject)}\text{content} \)
- \( \text{message} = \text{sender{subject}}\text{content} \)
- \( \text{message} = \text{sender<subject>content} \)
- \( \text{message} = \text{sender'subject'content} \)
- \( \text{message} = \text{sender"subject"content} \)

The proper message syntax and \textit{sender} email address syntax are dependent on your wireless carrier. To determine the message syntax, run the MobiLink Listener with message logging enabled, and with the verbosity level set to 2 using the \texttt{dblsn -m} and \texttt{-v} options. The message log contains the proper syntax when you initially run the MobiLink Listener.

When using a device tracking gateway, the message syntax depends on the subordinate gateway used to send the message. If you are using an SMTP subordinate gateway, the syntax is dependent on your public wireless carrier.

Remarks

Braces, chevrons, double quotations, parenthesis, single quotations, and square brackets are reserved for internal use, and should not be used within \textit{subject}. For more information about message limitations and restrictions, see “How to work with push requests” on page 7.

See also

- “MobiLink Listener keywords for Windows devices” on page 65
- “Gateways and carriers” on page 19
- “-m dblsn option” on page 57
- “-v dblsn option” on page 63
Sending a push notification using the sa_send_udp system procedure

A SQL Anywhere consolidated database can use the sa_send_udp system procedure to send push notifications to a device through a UDP gateway. This method is an alternative to sending push notifications with Notifiers.

Prerequisites

- A MobiLink Listener is set up on a device and listening for push notifications
- Internet Explorer is installed on the device
- The following command was run on the device:

  `dblsn -l "message=RunBrowser;action='START iexplore.exe http://www.sap.com';"`

- A SQL Anywhere consolidated database is running on the MobiLink server

Context and remarks

By appending a 1 to the end of your original message, and then using that message in the msg argument of an sa_send_udp system procedure, you send the original message to a MobiLink Listener.

Task

1. Run Interactive SQL and connect to your consolidated database using a command like the one below, replacing `consdb-source-name` with the ODBC name of your consolidated database.

   `dbisql -c "dsn=consdb-source-name"`

2. Execute the following statement to send the push notification:

   `CALL sa_send_udp('device-ip-address', 5001, 'RunBrowser1')`

   The first argument ensures that the push notification is sent to the correct device. Replace `device-ip-address` with the IP address of the device. If you are running the MobiLink Listener on the same computer as the MobiLink server, use `localhost`.

   The second argument is the port number. By default, MobiLink Listeners use port 5001 to listen for UDP.

   The third argument is the message to send with a 1 appended at the end. By appending a 1, which is a reserved server-initiated synchronization protocol, the RunBrowser message is sent to the device using a UDP gateway.

Results

When the system call is executed, the RunBrowser message is sent to the device, causing the device to run Internet Explorer and load the SAP home page.
Sending a push notification using the sa_send_udp system procedure

See also

- “sa_send_udp system function” [SQL Anywhere Server - SQL Reference]
Server-initiated synchronization tutorials

Use the following tutorials to gain a better understanding of how to use server-initiated synchronization.

Tutorial: Configuring server-initiated synchronization using light weight polling

This tutorial demonstrates how to configure a SQL Anywhere consolidated and remote database for server-initiated synchronization. It is based on the sample code located in %SQLANYSAMP16%\MobiLink\SIS_CarDealer_LP_DBLSN.

Sample implementations of server-initiated synchronization are located in %SQLANYSAMP16%\MobiLink. All server-initiated synchronization sample directory names begin with the SIS_ prefix.

Note
You can use Sybase Central to administer remote databases, and then use server-initiated remote tasks (SIRT) as an alternative to server-initiated synchronization using light weight polling. For more information, see “Server-initiated remote tasks (SIRT)” [MobiLink - Server Administration] and “Tutorial: Using central administration of remote databases” [MobiLink - Getting Started].

Required software
- SQL Anywhere 16

Competencies and experience
- Basic knowledge of MobiLink event scripts.

Privileges
You must have the following roles and privileges on the consolidated database:
- SYS_AUTHRESOURCE_ROLE compatibility role
- MONITOR system privilege

You must have the following roles and privileges on the remote database:
- SYS_REPLICATION_ADMIN_ROLE system role
- SYS_RUN_REPLICATION_ROLE system role

Goals
- Set up a SQL Anywhere consolidated database for server-initiated synchronization.
- Configure server-side properties.
- Issue push requests to prompt a server-initiated synchronization.
Suggested background reading

- “Server-initiated synchronization” on page 1

Lesson 1: Setting up the consolidated database

In this lesson, you create a consolidated database named SIS_CarDealer_LP_DBLSN_CONDB with the scripts required for synchronization using the dbinit utility. You then use the SQL Anywhere 16 driver to define an ODBC data source for the SIS_CarDealer_LP_DBLSN_CONDB database.

Prerequisites

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

Task

1. Create a new working directory to store the consolidated database.

   This tutorial assumes c:\MLsis as the working directory.

2. Create the SQL Anywhere consolidated database using the dbinit utility, and set the DBA user ID to DBA and password to sql.

   Change to the c:\MLsis directory and run the following command:
   
   `dbinit -dba DBA,sql SIS_CarDealer_LP_DBLSN_CONDB`

3. Start the consolidated database.

   Run the following command:
   
   `dbsrv16 SIS_CarDealer_LP_DBLSN_CONDB`

4. Click Start » Programs » SQL Anywhere 16 » Administration Tools » ODBC Data Source Administrator.

5. Click the User DSN tab, and then click Add.

6. In the Create New Data Source window, click SQL Anywhere 16 and click Finish.

7. Perform the following tasks in the ODBC Configuration For SQL Anywhere window:
   
   a. Click the ODBC tab.
   
   b. In the Data source name field, type SIS_CarDealer_LP_DBLSN_CONDB.
   
   c. Click the Login tab.
   
   d. In the User ID field, type DBA.
   
   e. In the Password field, type sql.
f. From the Action dropdown list, choose Connect to a running database on this computer.

g. In the Server name field, type SIS_CarDealer_LP_DBLSN_CONDB.

h. Click OK.

8. Close the ODBC data source administrator.

   Click OK on the ODBC Data Source Administrator window.

**Results**

The consolidated database is created and an ODBC data source is defined.

**Next**

Proceed to “Lesson 2: Generating a database schema” on page 93.

**See also**

- “ODBC data sources” [SQL Anywhere Server - Database Administration]

**Lesson 2: Generating a database schema**

In this lesson, you generate a database schema, which includes a Dealer table, a non_sync_request table, a download_cursor synchronization script. This database schema satisfies the requirements for generating push requests.

**Prerequisites**

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

**Task**

1. Click Start » Programs » SQL Anywhere 16 » Administration Tools » Sybase Central.

2. Perform the following tasks to connect to the consolidated database:

   a. Click Connections » Connect with SQL Anywhere 16.

   b. From the Action dropdown list, choose Connect with an ODBC Data Source.

   c. Click ODBC Data Source name, and click Browse.

   d. Select SIS_CarDealer_LP_DBLSN_CONDB and then click OK.

   e. Click Connect.

3. Connect to your database using Interactive SQL.

   You can start Interactive SQL from Sybase Central or at a command prompt.
To start Interactive SQL from Sybase Central, right-click the SIS_CarDealer_LP_DBLSN_CONDB - DBA database and click Open Interactive SQL.

To start Interactive SQL at a command prompt, run the following command:

dbisql -c "dsn=SIS_CarDealer_LP_DBLSN_CONDB"

4. Execute the following SQL statements to create and set up the Dealer and non_sync_request tables:

```sql
CREATE TABLE Dealer (
    name           VARCHAR(10) NOT NULL PRIMARY KEY,
    rating         VARCHAR(5),
    last_modified  TIMESTAMP DEFAULT CURRENT_TIMESTAMP
)

CREATE TABLE non_sync_request(
    poll_key       VARCHAR(128)
)
```

5. Insert data into the Dealer table using the following statements:

```sql
INSERT INTO Dealer(name, rating) VALUES ('Audi', 'a');
INSERT INTO Dealer(name, rating) VALUES ('Buick', 'b');
INSERT INTO Dealer(name, rating) VALUES ('Chrysler', 'c');
INSERT INTO Dealer(name, rating) VALUES ('Dodge', 'd');
INSERT INTO Dealer(name, rating) VALUES ('Eagle', 'e');
INSERT INTO Dealer(name, rating) VALUES ('Ford', 'f');
INSERT INTO Dealer(name, rating) VALUES ('Geo', 'g');
INSERT INTO Dealer(name, rating) VALUES ('Honda', 'h');
INSERT INTO Dealer(name, rating) VALUES ('Isuzu', 'I');
COMMIT;
```

6. Execute the following SQL statement to create the MobiLink system tables and stored procedures. Replace C:\Program Files\SQL Anywhere 16\ with the location of your SQL Anywhere 16 installation.

```sql
READ "C:\Program Files\SQL Anywhere 16\MobiLink\setup\syncsa.sql"
```

7. Run the following SQL script to specify a download_cursor synchronization script and record the synchronization state to the ml_sis_sync_state system table:

```sql
CALL ml_add_table_script(
    'CarDealer',
    'Dealer',
    'download_cursor',
    'SELECT * FROM Dealer WHERE last_modified >= ?'
);

CALL ml_add_connection_script(
    'CarDealer',
    'publication_nonblocking_download_ack',
    'CALL ml_set_sis_sync_state(
        {ml s.remote_id},
        NULL,
        {ml s.publication_name},
        {ml s.username},
        NULL,
        {ml s.last_publication_download}
    )',
);
```
CALL ml_add_table_script('CarDealer', 'Dealer', 'download_delete_cursor', '--{ml_ignore}');

COMMIT;

This script sets the ml_sis_sync_state to record download-only synchronization. Recording the synchronization state allows you to reference the ml_sis_sync_state system table from the request_cursor event. You specify the request_cursor event in the next lesson.

8. Close Interactive SQL.

Results

The database schema is created.

Next

Proceed to “Lesson 3: Creating a MobiLink project” on page 95.

See also

- “SQL Anywhere database server syntax” [SQL Anywhere Server - Database Administration]
- “CREATE TABLE statement” [SQL Anywhere Server - SQL Reference]
- “Synchronization script writing” [MobiLink - Server Administration]
- “download_cursor table event” [MobiLink - Server Administration]
- “publication_nonblocking_download_ack connection event” [MobiLink - Server Administration]

Lesson 3: Creating a MobiLink project

In this lesson, you connect to the consolidated database by creating a new MobiLink project.

Prerequisites

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

Create a new MobiLink project

1. Click Start » Programs » SQL Anywhere 16 » Administration Tools » Sybase Central.

2. Click Tools » MobiLink 16 » New Project.

3. In the Name field, type SIS_CarDealer_LP_DBLSN_CONDB_project.

4. In the Location field, type C:\MLsis, and then click Next.

5. In the Database display name field, type SIS_CarDealer_LP_DBLSN_CONDB.

6. Click Edit. The Connect To A Generic ODBC Database window appears.
7. In the **User ID** field, type **DBA**.

8. In the **Password** field, type **sql**.

9. In the **ODBC Data Source** name field, click **Browse**, and then select **SIS_CarDealer_LP_DBLSN_CONDB**.

10. Click **OK**, and then click **Save**.

11. Check the **Remember the password** option, and then click **Next**.

12. On the **New Remote Database Schema** page, select only the **Dealer** table to synchronize. Click **Next**.

13. Click **Next** again and then click **Finish**. Click **OK**.

### Results

The MobiLink project is created.

**Next**

Proceed to “Lesson 4: Configuring the Notifier” on page 96.

---

## Lesson 4: Configuring the Notifier

In this lesson, you configure a Notifier event to define how the Notifier creates push requests, and sends push notifications to devices.

### Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 92.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

### Context and remarks

The request_cursor event script detects push requests. Each push request determines what information is sent, and which device should receive the information.

### Task

1. In the left pane of Sybase Central under **MobiLink 16**, expand **SIS_CarDealer_LP_DBLSN_CONDB_project**, **Consolidated Databases** and then **SIS_CarDealer_LP_DBLSN_CONDB - DBA**.

2. Right-click **Notification**, and then click **New » Notifier**.
3. In the **What do you want to name the new notifier** field, type **CarDealerNotifier**.

4. Click **Finish**.

5. In the right pane, select **CarDealerNotifier**, and then click **Properties**.

6. Click the **Events** tab and click **request_cursor** from the **Events** list.

7. Type the following SQL statement in the provided text field:

   ```sql
   SELECT ml_sis_sync_state.remote_id + '.sync' FROM ml_sis_sync_state
   WHERE
   (  
   EXISTS (SELECT 1 FROM Dealer
       WHERE last_modified >= ml_sis_sync_state.last_download)
   AND EXISTS (SELECT poll_key FROM non_sync_request)
   )
   ```

8. Click **OK** to save the Notifier event.

**Results**

A Notifier is created and configured.

**Next**

Proceed to “Lesson 5: Starting the MobiLink server” on page 97.

**See also**

- “request_cursor event” on page 35
- “ml_set_sis_sync_state system procedure” on page 85

**Lesson 5: Starting the MobiLink server**

In this lesson, you start the MobiLink server with the Notifier so that push notifications can be sent to devices.

**Prerequisites**

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 92.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

**Task**

- Connect to your consolidated database.

  Run the following command:
mlsrv16 -notifier -c "dsn=SIS_CarDealer_LP_DBLSN_CONDB" -o serverOut.txt -v+ -dl -zu+ -x tcpip

The following table describes the mlsrv16 options used in this lesson. The options -o and -v provide debugging and troubleshooting information. Using these logging options is appropriate in a development environment. For performance reasons, -v is typically not used in production.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-notifier</td>
<td>Starts all enabled Notifiers for server-initiated synchronization. &lt;br&gt;See “-notifier mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-c</td>
<td>Specifies a connection string. &lt;br&gt;See “-c mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-o</td>
<td>Specifies the message log file serverOut.txt. &lt;br&gt;See “-o mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-v+</td>
<td>Specifies what information is logged. Using -v+ sets maximum verbose logging. &lt;br&gt;See “-v mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-zu+</td>
<td>Adds new users automatically. &lt;br&gt;See “-zu mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-x</td>
<td>Sets the communications protocol and protocol options for MobiLink clients. &lt;br&gt;See “-x mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
</tbody>
</table>

**Results**

The MobiLink server messages window appears. The Notifier indicates that it is ready to receive push notification requests from devices.

**Next**

Proceed to “Lesson 6: Setting up a remote database” on page 98.

**See also**

- “MobiLink server” [MobiLink - Server Administration]
- “MobiLink server options” [MobiLink - Server Administration]

**Lesson 6: Setting up a remote database**

In this lesson, you create a SQL Anywhere remote database, create a synchronization publication, a user, and a subscription.
Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 92.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

Task

1. Create your MobiLink client database using the dbinit command line utility.

   From the c:\MLsis directory, run the following command:

   ```
   dbinit -dba DBA,sql SIS_CarDealer_LP_DBLSN_REM
   ```

2. Start your MobiLink client database using the dbsrv16 command line utility.

   Run the following command:

   ```
   dbsrv16 SIS_CarDealer_LP_DBLSN_REM
   ```

3. Connect to your MobiLink client database using Interactive SQL.

   Run the following command:

   ```
   dbisql -c "SERVER=SIS_CarDealer_LP_DBLSN_REM;UID=DBA;PWD=sql"
   ```

4. Create the Dealer table in the remote database.

   Execute the following SQL statements in Interactive SQL:

   ```sql
   CREATE TABLE Dealer (  
     name VARCHAR(10) NOT NULL PRIMARY KEY,  
     rating VARCHAR(5),  
     last_modified TIMESTAMP DEFAULT CURRENT_TIMESTAMP
   )
   COMMIT;
   ```

5. Create your MobiLink synchronization user, publication, and subscription.

   Execute the following SQL statements in Interactive SQL:

   ```sql
   CREATE PUBLICATION CarDealer(TABLE DEALER WHERE 0=1)  
   CREATE SYNCHRONIZATION USER test_mluser OPTION ScriptVersion='CarDealer'  
   CREATE SYNCHRONIZATION SUBSCRIPTION TO CarDealer FOR test_mluser  
   SET OPTION public.ml_remote_id = remote_id;
   COMMIT;
   ```

Results

A SQL Anywhere remote database, synchronization publication, user, and subscription are all created.
Lesson 7: Configuring the MobiLink Listener

In this lesson, you configure the MobiLink Listener by storing the MobiLink Listener options in a text file, and then running dblsn with the file name specified at the command line.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 92.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

Task

1. Run the following command to synchronize with the MobiLink server and create the
   SIS_CarDealer_LP_DBLSN_REM.rid file:

   dbmlsync -c "SERVER=SIS_CarDealer_LP_DBLSN_REM;UID=DBA;PWD=sql" -e sa=on -o rem1.txt -v+

   The MobiLink Listener can use the $remote_id action variable to define a poll key, which the
   MobiLink server uses to identify the device. This variable is retrieved from the remote ID file,
   SIS_CarDealer_LP_DBLSN_REM.rid, which is created during the initial synchronization with the
   MobiLink server. You must synchronize with the MobiLink server to make use of the remote ID file.

2. Click Shut Down on the SQL Anywhere MobiLink client window.

3. Create a MobiLink Listener command file by creating a text file with the following contents:

   # Verbosity level
   -v2
# Show notification messages in console and log
-m

# Truncate, then write output to dblsn.txt
-ot dblsn.txt

# Remote ID file (defining the scope of $remote_id)
-r SIS_CarDealer_LP_DBLSN_REM.rid

# Message handlers

# Watch for a notification without action
-l "poll_connect='tcpip(host=localhost)';
   poll_notifier=CarDealerNotifer;
   poll_key=$remote_id.no_action;"

# Signal dbmlsync to launch, sync and then shutdown
-l "poll_connect='tcpip(host=localhost)';
   poll_notifier=CarDealerNotifier;
   poll_key=$remote_id.sync;
   action='run dbmlsync.exe -c
   SERVER=SIS_CarDealer_LP_DBLSN_REM;UID=DBA;PWD=sql -e sa=on -o rem1.txt -v +';"

# Shutdown the MobiLink Listener
-l "poll_connect='tcpip(host=localhost)';
   poll_notifier=CarDealerNotifier;
   poll_key=$remote_id.shutdown;
   action='DBLSN FULL SHUTDOWN';"

4. This tutorial assumes c:\MLsis as the working directory for server-side components. Save the text file as mydblsn.txt in this directory.

5. Start the MobiLink Listener.

   At a command prompt, navigate to c:\MLsis or to the directory where you saved your MobiLink Listener command file.

   Start the MobiLink Listener by running the following command:

   dbsn @mydblsn.txt

   The **MobiLink Listener for Windows** window appears, indicating the MobiLink Listener is sleeping.

**Results**

The MobiLink Listener is configured.

**Next**

Proceed to “Lesson 8: Issuing push requests” on page 102.
Lesson 8: Issuing push requests

In this lesson, you make a change to the Dealer table in the consolidated database so that the information can be downloaded into the remote database when the MobiLink Listener polls for push notifications. You then prompt a server-initiated synchronization by inserting a poll key value into the consolidated database. The Notifier runs the request_cursor event, detects the poll key in the non_sync_request table, then sends a push notification to the MobiLink Listener. When the MobiLink Listener receives the push notification, it synchronizes with the MobiLink database and updates the remote database.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 92.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

Task

1. Connect to your consolidated database in Interactive SQL if you are not already connected.

   Run the following command:

   ```
   dbisql -c "dsn=SIS_CarDealer_LP_DBLSN_CONDB"
   ```

2. Execute the following SQL statements:

   ```
   UPDATE Dealer
   SET RATING = 'B' WHERE name = 'Geo';
   COMMIT;
   ```

3. Issue push requests by populating the non_sync_request table directly. The poll key column determines which device should receive push notifications.

   Execute the following SQL statements:

   ```
   INSERT INTO non_sync_request(poll_key) VALUES ('%remote_id%.no_action');
   COMMIT;
   ```

4. Wait a few seconds for the synchronization to occur.

   The MobiLink Listener should poll the consolidated database, download the push notification, then update the Dealer table on the remote database.
5. Stop server-initiated synchronization with a device by deleting the poll key value from the non_sync_request table on the consolidated database.

   Execute the following SQL statements:
   
   ```sql
   DELETE FROM non_sync_request WHERE poll_key = '%remote_id%.no_action';
   COMMIT;
   ```

6. Confirm that the Dealer table on the remote database was updated.

   Execute the following SQL statement:
   
   ```sql
   SELECT * FROM Dealer
   ```

   The rating for Geo should now be B.

**Results**

A change is made in the consolidated database and server-initiated synchronization is initiated.

**Next**

Proceed to “Cleaning up” on page 103.

**See also**

- “Generating push requests” on page 7
- “INSERT statement” [SQL Anywhere Server - SQL Reference]
- “UPDATE statement” [SQL Anywhere Server - SQL Reference]
- “DELETE statement” [SQL Anywhere Server - SQL Reference]

**Cleaning up**

Remove tutorial materials from your computer.

**Prerequisites**

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 92.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using light weight polling” on page 91.

**Task**

1. Close Interactive SQL.

2. Close the SQL Anywhere, MobiLink, and synchronization client windows.

3. Delete all tutorial-related ODBC data sources.
a. Start the ODBC Data Source Administrator.
   At a command prompt, type the following command:

   odbcad32

b. Remove the **SIS_CarDealer_LP_DBLSN_CONDB** data source.

4. Navigate to the directory containing your consolidated and remote databases, `c:\MLsis\`, and delete all the files.

**Results**

The tutorial materials are removed from your computer.

**Next**

None.

---

**Tutorial: Configuring server-initiated synchronization using gateways**

This tutorial demonstrates how to configure a SQL Anywhere consolidated and remote database for server-initiated synchronization. It is based on the sample code located in `%SQLANYSAMP16%\MobiLink\SIS_CarDealer`.

Several sample implementations of server-initiated synchronization are located in `%SQLANYSAMP16%\MobiLink`. All server-initiated synchronization sample directory names begin with the SIS_ prefix.

**Required software**

- SQL Anywhere 16

**Competencies and experience**

- Basic knowledge of MobiLink event scripts.

**Privileges**

You must have the following roles and privileges on the consolidated database:

- **SYS_AUTHRESOURCE_ROLE** compatibility role
- **MONITOR** system privilege

You must have the following roles and privileges on the remote database:

- **SYS_REPLICATION_ADMIN_ROLE** system role
- **SYS_RUN_REPLICATION_ROLE** system role
Goals

- Set up a SQL Anywhere consolidated database for server-initiated synchronization.
- Configure server-side properties.
- Issue push requests to prompt a server-initiated synchronization.

Suggested background reading

- “Server-initiated synchronization” on page 1

Lesson 1: Setting up the consolidated database

In this lesson, you create a consolidated database named **MLconsolidated** with the scripts required for synchronization using the dbinit utility. You then define an ODBC data source for the database.

Prerequisites

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task

1. Create a new working directory to store the consolidated database.
   
   This tutorial assumes C:\MLsis as the working directory.

2. Create the SQL Anywhere consolidated database using the dbinit utility.

3. Run the following command:

   ```
   dbinit -dba DBA,sql MLconsolidated
   ```

4. Start the consolidated database using the dbsrv16 utility.

   Run the following command:

   ```
   dbsrv16 MLconsolidated
   ```

5. Click Start » Programs » SQL Anywhere 16 » Administration Tools » ODBC Data Source Administrator.

6. Click the User DSN tab, and then click Add.

7. In the Create New Data Source window, click SQL Anywhere 16, and then click Finish.

8. Perform the following tasks in the ODBC Configuration For SQL Anywhere window:
   a. Click the ODBC tab.
   b. In the Data source name field, type sis_cons.
c. Click the Login tab.

d. In the User ID field, type DBA.
e. In the Password field, type sql.
f. From the Action dropdown list, choose Connect to a running database on this computer.
g. In the Server name field, type MLconsolidated.
h. Click OK.

9. Close the ODBC data source administrator.

Click OK on the ODBC Data Source Administrator window.

Results

The consolidated database is created and an ODBC data source is defined.

Next

Proceed to “Lesson 2: Generating a database schema” on page 106.

See also

- “ODBC data sources” [SQL Anywhere Server - Database Administration]

Lesson 2: Generating a database schema

In this lesson, you generate the database schema, which includes a Dealer table and a download_cursor synchronization script. A table and stored procedure is used to generate server-initiated synchronization push requests.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task

1. Click Start » Programs » SQL Anywhere 16 » Administration Tools » Sybase Central.

2. Perform the following tasks to connect to the consolidated database:
   a. Click Connections » Connect with SQL Anywhere 16.
   b. In the User ID field, type DBA.
   c. In the Password field, type sql.
d. From the **Action** dropdown list, click **Connect with an ODBC Data Source**.

e. Click **ODBC Data Source name**, and click **Browse**.

f. Select **sis_cons**, and then click **OK**.

g. Click **Connect**.

3. Connect to your database using Interactive SQL.

You can start Interactive SQL from Sybase Central or at a command prompt.

- To start Interactive SQL from Sybase Central, right-click the **MLconsolidated - DBA** database and click **Open Interactive SQL**.
- To start Interactive SQL at a command prompt, run the following command:

  ```
  dbisql -c "dsn=sis_cons"
  ```

4. Run the following SQL statement to create and set up the Dealer table:

   ```
   CREATE TABLE Dealer (  
   name VARCHAR(10) NOT NULL PRIMARY KEY,  
   rating VARCHAR(5),  
   last_modified TIMESTAMP DEFAULT CURRENT_TIMESTAMP  
   )
   ```

5. Insert data into the Dealer table using the following statements:

   ```
   INSERT INTO Dealer(name, rating) VALUES ('Audi', 'a');
   INSERT INTO Dealer(name, rating) VALUES ('Buick', 'b');
   INSERT INTO Dealer(name, rating) VALUES ('Chrysler', 'c');
   INSERT INTO Dealer(name, rating) VALUES ('Dodge', 'd');
   INSERT INTO Dealer(name, rating) VALUES ('Eagle', 'e');
   INSERT INTO Dealer(name, rating) VALUES ('Ford', 'f');
   INSERT INTO Dealer(name, rating) VALUES ('Geo', 'g');
   INSERT INTO Dealer(name, rating) VALUES ('Honda', 'h');
   INSERT INTO Dealer(name, rating) VALUES ('Isuzu', 'I');
   COMMIT;
   ```

6. Run the following SQL script to create the MobiLink system tables and stored procedures. Replace `C:\Program Files\SQL Anywhere 16\` with the location of your SQL Anywhere 16 installation.

   ```
   READ "C:\Program Files\SQL Anywhere 16\MobiLink\setup\syncsa.sql"
   ```

7. Run the following SQL script to specify a `download_cursor` synchronization script and record the synchronization:

   ```
   CALL ml_add_table_script(  
   'sis_ver1',  
   'Dealer',  
   'download_cursor',  
   'SELECT * FROM Dealer WHERE last_modified >= ?'
   );
   CALL ml_add_table_script(  
   'sis_ver1', 'Dealer', 'download_delete_cursor', '---{ml_ignore}'
   );
   COMMIT
   ```
Do not close Interactive SQL.

Results
The database schema is generated, which includes a Dealer table and a download_cursor synchronization script, and MobiLink system tables and stored procedures are installed.

Next
Proceed to “Lesson 3: Creating a table to store push request” on page 108.

See also
● “SQL Anywhere database server syntax” [SQL Anywhere Server - Database Administration]
● “CREATE TABLE statement” [SQL Anywhere Server - SQL Reference]
● “Synchronization script writing” [MobiLink - Server Administration]
● “download_cursor table event” [MobiLink - Server Administration]

Lesson 3: Creating a table to store push request
In this lesson, you create a push request table for storing push requests. The Notifier sends a message to a device when it detects a push request.

Prerequisites
This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task
1. You should be connected to your database in Interactive SQL from the previous lesson.

   If you are not connected to your database, you can start Interactive SQL from Sybase Central or at a command prompt.

   ■ To start Interactive SQL from Sybase Central, right-click the MLconsolidated - DBA database and click Open Interactive SQL.

   ■ To start Interactive SQL at a command prompt, run the following command:

     `dbisql -c "dsn=sis_cons"

2. Run the following SQL statements in Interactive SQL:

   ```sql
   CREATE TABLE PushRequest (
       req_id INTEGER DEFAULT AUTOINCREMENT PRIMARY KEY,
       mluser VARCHAR(128),
       subject VARCHAR(128),
       content VARCHAR(128),
   )
   ```
3. Close Interactive SQL.

**Results**

A push request table is created for storing push requests.

**Next**

Proceed to “Lesson 4: Creating a MobiLink project” on page 109.

**See also**

- “Push requests” on page 5
- “Server-initiated synchronization” on page 1
- “Server-initiated synchronization components” on page 2

**Lesson 4: Creating a MobiLink project**

In this lesson, you connect to the consolidated database by creating a new MobiLink project.

**Prerequisites**

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

**Create a new MobiLink project**

1. Click Start » Programs » SQL Anywhere 16 » Administration Tools » Sybase Central.
2. Click Tools » MobiLink 16 » New Project.
3. In the **Name** field, type **sis_cons_project**.
4. In the **Location** field, type **C:\MLsis**, and then click Next.
5. In the **Database display name** field, type **sis_cons**.
6. Click **Edit**. The **Connect To A Generic ODBC Database** window appears.
7. In the **User ID** field, type **DBA**.
8. In the **Password** field, type **sql**.
9. In the **ODBC Data Source name** field, click **Browse**, and then select **sis_cons**.

10. Click **OK**, and then click **Save**.

11. Check the **Remember the password** option, and then click **Next**.

12. Accept the defaults on the **New Remote Database Schema** page and click **Next**.

13. Click **Next** and then click **Finish**. Click **OK**.

**Results**

The MobiLink project is created.

**Next**

Proceed to “Lesson 5: Configuring the Notifier” on page 110.

**Lesson 5: Configuring the Notifier**

In this lesson, you configure three Notifier events to define how the Notifier creates push requests, transmits the requests to MobiLink Listeners, and deletes expired requests.

**Prerequisites**

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

**Context and remarks**

The Notifier detects changes in the consolidated database and creates push requests using the begin_poll event. In this case, the begin_poll script populates the PushRequest table if changes occur in the Dealer table and when a remote database is not up-to-date.

The request_cursor script fetches push requests. Each push request determines what information is sent in the message, and which remote databases receive the information.

The request_delete Notifier event specifies cleanup operations. Using this script, the Notifier can automatically remove implicitly dropped and expired requests.

**Task**

1. In the left pane of Sybase Central under **MobiLink 16**, expand **sis_cons_project**, **Consolidated Databases** and then **sis_cons**.

2. Right-click **Notification**, and then click **New** » **Notifier**.
3. In the **What do you want to name the new notifier field**, type **CarDealerNotifier**.

4. Click **Finish**.

5. Enter the **begin_poll** event script.
   a. In the right pane, select **CarDealerNotifier**, and then click **File»Properties**.
   b. Click the **Events** tab.
   c. Choose **begin_poll** from the **Events** list.
   d. Type the following SQL statements in the provided text field:

   ```sql
   -- Insert the last consolidated database modification date into @last_modified
   --
   DECLARE @last_modified timestamp;
   SELECT MAX(last_modified) INTO @last_modified FROM Dealer;
   
   -- Delete processed requests if the mluser is up-to-date
   --
   DELETE FROM PushRequest
   FROM PushRequest AS p, ml_user AS u, ml_subscription AS s
   WHERE p.status = 'processed'
   AND u.name = p.mluser
   AND u.user_id = s.user_id
   AND @last_modified <= GREATER(s.last_upload_time, s.last_download_time);
   
   -- Insert new requests when a device is not up-to-date
   --
   INSERT INTO PushRequest(mluser, subject, content)
   SELECT u.name, 'sync', 'ignored'
   FROM ml_user as u, ml_subscription as s
   WHERE u.name IN (SELECT name FROM ml_listening WHERE listening = 'y')
   AND u.user_id = s.user_id
   AND @last_modified > greater(s.last_upload_time, s.last_download_time)
   AND u.name NOT LIKE '%-dblsn'
   AND NOT EXISTS(SELECT * FROM PushRequest
   WHERE PushRequest.mluser = u.name
   AND PushRequest.subject = 'sync')
   ```

   In the first major section of the **begin_poll** script, processed requests from the PushRequest table are eliminated if a device is up to date:

   ```sql
   @last_modified <= GREATER(s.last_upload_time, s.last_download_time)
   ```

   @last_modified is the maximum modification date in the consolidated database Dealer table. The expression `greater(s.last_upload_time, s.last_download_time)` represents the last synchronization time for a remote database.

   You can also delete push requests directly using the request_delete event. However, the **begin_poll** event, in this case, ensures that expired or implicitly dropped requests are not eliminated before a remote database synchronizes.
The next section of code checks for changes in the last_modified column of the Dealer table and issues push requests for all active MobiLink Listeners (listed in the ml_listening table) that are not up to date:

@last_modified > GREATER(s.last_upload_time, s.last_download_time)

When populating the PushRequest table, the begin_poll script sets the subject to 'sync'.  

6. Enter the request_cursor script.
   a. Click request_cursor from the Events list.
   b. Type the following SQL statement in the provided text field:

   ```sql
   SELECT
       p.req_id,
       'Default-DeviceTracker',
       p.subject,
       p.content,
       p.mluser,
       p.resend_interval,
       p.time_to_live
   FROM PushRequest AS p
   ```

   The PushRequest table supplies rows to the request_cursor script.  
   The order and values in the request_cursor result set is significant. The second parameter, for example, defines the default gateway Default-DeviceTracker. A device tracking gateway keeps track of how to reach users and automatically selects UDP or SMTP to connect to remote devices.

7. Enter the request_delete script.
   a. Click request_delete from the Events list.
   b. Type the following SQL statement in the provided text field:

   ```sql
   UPDATE PushRequest SET status='processed' WHERE req_id = ?
   ```

   Instead of deleting the row, this request_delete script updates the status of a row in the PushRequest table to 'processed'.

8. Click OK to save the Notifier events.

**Results**

Three Notifier events are defined.

**Next**

Proceed to “Lesson 6: Configuring gateways and carriers” on page 113.
Lesson 6: Configuring gateways and carriers

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Gateways are the mechanisms for sending messages. You can define either a supported gateway or a device tracking gateway. The MobiLink server keeps track of how to reach clients when you specify a device tracking gateway, and automatically chooses the most appropriate gateway.

You use a default device tracking gateway for the purpose of this tutorial, so configuration is not necessary.

Proceed to “Lesson 7: Starting the MobiLink server” on page 113.

See also

- “Gateways as an alternative to light weight pollers” on page 19
- “Gateways and carriers” on page 19
- “Device tracking gateway properties” on page 44

Lesson 7: Starting the MobiLink server

In this lesson, you start the MobiLink server with the Notifier so that push notifications can be sent to devices.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task

- Connect to your consolidated database.

Run the following command:
mlsrv16 -notifier -c "dsn=sis_cons" -o serverOut.txt -v+ -dl -zu+ -x tcpip

The following table describes the mlsrv16 options used in this lesson. The options -o and -v provide debugging and troubleshooting information. Using these logging options is appropriate in a development environment. For performance reasons, -v is typically not used in production.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-notifier</td>
<td>Starts all enabled Notifiers for server-initiated synchronization.</td>
</tr>
<tr>
<td></td>
<td>See “-notifier mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-c</td>
<td>Specifies a connection string.</td>
</tr>
<tr>
<td></td>
<td>See “-c mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-o</td>
<td>Specifies the message log file serverOut.txt.</td>
</tr>
<tr>
<td></td>
<td>See “-o mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-v+</td>
<td>Specifies what information is logged. Using -v+ sets maximum verbose logging</td>
</tr>
<tr>
<td></td>
<td>See “-v mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-zu+</td>
<td>Adds new users automatically.</td>
</tr>
<tr>
<td></td>
<td>See “-zu mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
<tr>
<td>-x</td>
<td>Sets the communications protocol and protocol options for MobiLink clients.</td>
</tr>
<tr>
<td></td>
<td>See “-x mlsrv16 option” [MobiLink - Server Administration].</td>
</tr>
</tbody>
</table>

Results

The MobiLink server messages window appears. The Notifier indicates that it is ready to receive push notification requests from devices.

Next

Proceed to “Lesson 8: Setting up a remote database” on page 115.

See also

For more information about the topics in this lesson, see:

- “MobiLink server” [MobiLink - Server Administration]
- “MobiLink server options” [MobiLink - Server Administration]
Lesson 8: Setting up a remote database

In this lesson, you create a SQL Anywhere remote database, create a synchronization publication, a user, and a subscription.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task

1. Create your MobiLink client database using the dbinit command line utility.

   Run the following command:
   
   ```
   dbinit -dba DBA,sql remotel
   ```

2. Start your MobiLink client database using the dbsrv16 command line utility.

   Run the following command:
   
   ```
   dbsrv16 remotel
   ```

3. Connect to your MobiLink client database using Interactive SQL.

   Run the following command:
   
   ```
   dbisql -c "SERVER=remotel;UID=DBA;PWD=sql"
   ```

4. Create the Dealer table.

   Execute the following SQL statements in Interactive SQL:
   
   ```
   CREATE TABLE Dealer (  
     name VARCHAR(10) NOT NULL PRIMARY KEY,  
     rating VARCHAR(5),  
     last_modified TIMESTAMP DEFAULT CURRENT_TIMESTAMP
   )  
   COMMIT;
   ```

5. Create your MobiLink synchronization user, publication, and subscription.

   Execute the following SQL statements in Interactive SQL:
   
   ```
   CREATE PUBLICATION car_dealer_pub (table Dealer);  
   CREATE SYNCHRONIZATION USER sis_user1;  
   CREATE SYNCHRONIZATION SUBSCRIPTION  
     TO car_dealer_pub  
     FOR sis_user1  
     OPTION scriptversion='sis_ver1';  
   COMMIT;
   ```
Results

A SQL Anywhere remote database, synchronization publication, user, and subscription are created.

Next

Proceed to “Lesson 9: Configuring the MobiLink Listener” on page 116.

See also

- “MobiLink clients” [MobiLink - Client Administration]
- “CREATE TABLE statement” [SQL Anywhere Server - SQL Reference]
- “Publications” [MobiLink - Client Administration]
- “CREATE PUBLICATION statement [MobiLink] [SQL Remote]” [SQL Anywhere Server - SQL Reference]
- “CREATE SYNCHRONIZATION USER statement [MobiLink]” [SQL Anywhere Server - SQL Reference]
- “CREATE SYNCHRONIZATION SUBSCRIPTION statement [MobiLink]” [SQL Anywhere Server - SQL Reference]
- “Script versions” [MobiLink - Server Administration]

Lesson 9: Configuring the MobiLink Listener

In this lesson, you configure the MobiLink Listener by storing the MobiLink Listener options in a text file, and then running dblsn with the file name specified at the command line.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task

1. MobiLink Listener command file

Create a MobiLink Listener command file by creating a text file with the following contents:

```
#----------------------------------
# Verbosity level
-v2
# Show notification messages in console and log
-m
# Polling interval, in seconds
-i 3
# Truncate, then write output to dblsn.txt
-ot dblsn.txt
```
2. This tutorial assumes `c:\MLsis` as the working directory for server-side components. Save the text file as `mydblsn.txt` in this directory.

3. Start the MobiLink Listener.

   At a command prompt, navigate to `c:\MLsis` or the directory where you saved your MobiLink Listener command file.

   Start the MobiLink Listener by running the following command:

   ```
dblsn @mydblsn.txt
   ```

Results

The MobiLink Listener for Windows window appears, indicating the MobiLink Listener is sleeping.

When tracking information is uploaded to the consolidated database, a new entry appears in the MobiLink server messages window. This information relays the successful initial communication between the MobiLink Listener and the MobiLink server.

Next

Proceed to “Lesson 10: Issuing push requests” on page 117.

See also

- “Listeners” on page 12
- “MobiLink Listener utility for Windows devices (dblsn)” on page 49
- “@data dblsn option” on page 53

Lesson 10: Issuing push requests

For server-initiated synchronization, you can issue push requests by populating the PushRequest table directly, or making a change in the Dealer table. In the latter case, the Notifier begin_poll script detects the change in the Dealer table and populate the PushRequest table. In either case, the PushRequest table supplies rows to the Notifier request_cursor script, which determines how remote devices receive messages.
**Prerequisites**

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

**Insert a push request directly into the PushRequest table prompting server-initiated synchronization**

1. Connect to your consolidated database in Interactive SQL if you are not already connected.

   Run the following command:
   
   ```
   dbisql -c "dsn=sis_cons"
   ```

2. Execute the following SQL statements:

   ```
   INSERT INTO PushRequest(mluser, subject, content)
   VALUES ('sis_user1', 'sync', 'not used');
   COMMIT;
   ```

3. Wait a few seconds for the synchronization to occur.

   When populated, the PushRequest table supplies rows to the Notifier's request_cursor script. The request_cursor script determines what information is sent in the message, and which remote devices receive the information.

4. Execute the following SQL statements to make a change in the Dealer table on the consolidated database, prompting server-initiated synchronization:

   ```
   UPDATE Dealer
   SET RATING = 'B' WHERE name = 'Geo';
   COMMIT;
   ```

5. Wait a few seconds for the synchronization to occur.

   In this case, the Notifier begin_poll script detects changes in the dealer table and populates the PushRequest table appropriately. As before, once the PushRequest table is populated, the Notifier request_cursor script determines what information is sent in the message, and which remote devices receive the information.

6. Confirm that the Dealer table on the remote database was updated.

   Execute the following SQL statement:
   
   ```
   SELECT * FROM Dealer
   ```

   The rating for Geo should now be B.

**Results**

A push request is inserted directly into the PushRequest table, prompting server-initiated synchronization.
Cleaning up

Remove tutorial materials from your computer.

Prerequisites

This lesson assumes you have completed all preceding lessons. See “Lesson 1: Setting up the consolidated database” on page 105.

This lesson assumes that you have the roles and privileges listed in the Privileges section at the start of this tutorial: “Tutorial: Configuring server-initiated synchronization using gateways” on page 104.

Task

1. Close Interactive SQL.

2. Close the SQL Anywhere, MobiLink, and synchronization client windows.

3. Delete all tutorial-related ODBC data sources.
   a. Start the ODBC Data Source Administrator.
      At a command prompt, type the following command:
      
      `odbcad32`
   b. Remove the sis_cons data source.

4. Navigate to the directory containing your consolidated and remote databases, `c:\MLsis\`, and delete all the files.

Results

The tutorial materials are removed from your computer.

Next

None.
Index

Symbols
-a option
   MobiLink Listener utility (dblsn), 54
-d option
   MobiLink Listener utility (dblsn), 54
-e option
   MobiLink Listener utility (dblsn), 55
-f option
   MobiLink Listener utility (dblsn), 55
-gi option
   MobiLink Listener utility (dblsn), 56
-i option
   MobiLink Listener utility (dblsn), 56
-l option
   MobiLink Listener utility (dblsn), 56
-ls option
   MobiLink Listener utility (dblsn), 57
-lu option
   MobiLink Listener utility (dblsn), 57
-m option
   MobiLink Listener utility (dblsn), 57
-ni option
   MobiLink Listener utility (dblsn), 58
-notifier option
   starting a notifier, 11
-o option
   MobiLink Listener utility (dblsn), 58
-os option
   MobiLink Listener utility (dblsn), 58
-ot option
   MobiLink Listener utility (dblsn), 59
-p option
   MobiLink Listener utility (dblsn), 59
-pc option
   MobiLink Listener utility (dblsn), 59
-q option
   MobiLink Listener utility (dblsn), 60
-qi option
   MobiLink Listener utility (dblsn), 60
-r option
   MobiLink Listener utility (dblsn), 60
-sv option
   MobiLink Listener utility (dblsn), 61
-t option
   MobiLink Listener utility (dblsn), 61
-ts option
   MobiLink Listener utility (dblsn), 61
-u option
   MobiLink Listener utility (dblsn), 63
-v option
   MobiLink Listener utility (dblsn), 63
-w option
   MobiLink Listener utility (dblsn), 64
-x option
   MobiLink Listener utility (dblsn), 64
-y option
   MobiLink Listener utility (dblsn), 64
@data option
   MobiLink Listener utility (dblsn), 64
_BEST_IP_CHANGED_
   about, 17
_generic_
   MobiLink server-initiated synchronization
   network_provider_id, 48
_IP_CHANGED_
   about, 17

A
action keywords
   summary, 65
action variables
   about, 15
actions
   about, 14
altactions
   about, 14
architectures
   server-initiated synchronization, 1
auth_status enumeration
   MLLightPoller class [light weight polling API], 77

B
begin_connection event
   Notifier event, 37
begin_poll event
   Notifier event, 31

C
C development
   light weight polling API, 75
carrier properties
Index

summary, 48

carriers
  about, 23
command line utilities
  MobiLink Listener (dblsn) syntax, 49
common properties
  summary, 41
configuring server-initiated synchronization
  ml_add_property system procedure, 25
  Notifier configuration file, 28
  Sybase Central, 26
confirmation handling
  server-initiated synchronization, 38
confirmation_handler event
  Notifier event, 38
connectivity-initiated synchronization
  about, 17
content
  MobiLink Listener utility (dblsn), 13

D

dblsn full shutdown action command
  MobiLink Listener utility (dblsn), 70
dblsn utility
  action commands summary, 67
  action variables summary, 71
  keywords summary, 65
  options, 51
  syntax, 49
delivery confirmation
  handling, 38
deploying
  MobiLink Listener, 3
deployment considerations
  server-initiated synchronization, 3
device tracking
  limitations, 3
  setting up, 22
  SQL Anywhere 9.0.0, 20
device tracking gateway
  about gateways, 19
device tracking gateway properties
  summary, 44
device tracking gateways
  about, 19

E

dbnsn full shutdown action command
  MobiLink Listener utility (dblsn), 70
dblsn utility
  action commands summary, 67
  action variables summary, 71
  keywords summary, 65
  options, 51
  syntax, 49
delivery confirmation
  handling, 38
deploying
  MobiLink Listener, 3
deployment considerations
  server-initiated synchronization, 3
device tracking
  limitations, 3
  setting up, 22
  SQL Anywhere 9.0.0, 20
device tracking gateway
  about gateways, 19
device tracking gateway properties
  summary, 44
device tracking gateways
  about, 19

F

filter keywords
  summary, 65
filter-action pairs
dblsn, 56
filtering by remote ID
  server-initiated synchronization, 16
filtering messages
  about, 13

G

Gateway properties
  about, 43
gateways
  about, 19
tutorial, 104
gateways and carriers
  about, 19

L

libraries
  MobiLink listening libraries, 50
light weight pollers
  about, 18
Light weight polling
  API, 75
  limitations, 3
  MobiLink Listener polling options, 15
tutorial, 91
light weight polling API
  description, 75
  MLLightPoller class, 75
  MLLPCreatePoller method, 78
  MLLPDestroyPoller method, 79
  limitations
    server-initiated synchronization, 3
    Listeners
about, 12
limitations, 3
setting up message handlers, 12
listening libraries
server-initiated synchronization, 50
lsn_udp16.dll
server-initiated synchronization, 51

M
message
MobiLink Listener utility (dblsn), 14
message handlers
about, 12
dblsn syntax, 56
message syntax
summary, 87
message_start
MobiLink Listener utility (dblsn), 14
ml_add_property system procedure
configuring server-initiated synchronization, 25
ml_delete_device system procedure
syntax, 81
ml_delete_device_address system procedure
syntax, 81
ml_delete_listening system procedure
syntax, 82
ml_set_device system procedure
syntax, 82
ml_set_device_address system procedure
syntax, 83
ml_set_listening system procedure
syntax, 84
ml_set_sis_sync_state system procedure
syntax, 85
MLLightPoller class [light weight polling API]
auth_status enumeration, 77
description, 75
Poll method, 76
return_code enumeration, 78
SetConnectInfo method, 77
MLLPCreatePoller method [light weight polling API]
description, 78
MLLPDestroyPoller method [light weight polling API]
description, 79
MobiLink
server-initiated synchronization, 1
MobiLink Listener utility (dblsn)
action commands summary, 67
action variables summary, 71
keywords summary, 65
options, 51
syntax, 49
MobiLink server farm
Notifiers, 10
MobiLink server-side settings
setting for server-initiated synchronization, 25
MobiLink synchronization
server-initiated synchronization, 1
multi-channel listening
server-initiated synchronization, 54

N
Notifier configuration file
about, 28
configuring server-initiated synchronization, 28
Notifier events
about, 30
begin_connection event, 37
begin_poll event, 31
confirmation_handler event, 38
derial_connection event, 38
derial_poll event, 31
error_handler event, 32
request_cursor event, 35
request_delete event, 36
shutdown_query event, 37
Notifier properties
summary, 42
Notifiers
-notifier mlsrv16 option, 11
about, 10
MobiLink server farm, 10
setting up, 11
notifying a MobiLink Listener with sa_send_udp
about, 88

O
options
summary, 66

P
persistent connections
server-initiated synchronization, 59
Index

Poll method
  MLLightPoller class [light weight polling API], 76
polling options
  summary, 65
post action command
  MobiLink Listener utility (dblsn), 69
posting
  window messages to window classes in MobiLink, 69
push request tables
  about, 5
push requests
  about, 5
  creating a push request table, 5
  deleting, 36
  detecting, 35
  generating, 7

Q
quick start
  server-initiated synchronization, 3

R
remote IDs
  filtering, 16
request_cursor event
  Notifier event, 35
request_delete event
  Notifier event, 36
return_code enumeration
  MLLightPoller class [light weight polling API], 78
run action command
  MobiLink Listener utility (dblsn), 68

S
sa_send_udp system procedure
  notifying a MobiLink Listener, 88
sample applications
  server-initiated synchronization using gateways, 104
  server-initiated synchronization using light weight polling, 91
samples
  server-initiated synchronization, 91
sender
  MobiLink Listener utility (dblsn), 14
server-initiated synchronization
  about, 1
  architecture, 1
  components, 2
  listening libraries, 50
  quick start, 3
  samples, 91
  setting MobiLink server-side settings, 25
  supported platforms, 3
  system procedures, 81
  tutorials, 91
SetConnectInfo method
  MLLightPoller class [light weight polling API], 77
setting up server-initiated synchronization
  about, 5
shutdown_query event
  Notifier event, 37
SMS listening
  enabling, 57
SMTP gateway
  about gateways, 19
SMTP gateway properties
  summary, 45
socket action command
  MobiLink Listener utility (dblsn), 70
SQL Anywhere 9.0.0
  device tracking for, 20
start action command
  MobiLink Listener utility (dblsn), 68
subject
  MobiLink Listener utility (dblsn), 13
supported platforms
  server-initiated synchronization, 3
SYNC gateway
  about gateways, 19
SYNC gateway properties
  summary, 46
synchronization
  server-initiated, 1
syntax
  MobiLink Listener utility (dblsn), 49
  MobiLink server-initiated synchronization system procedures, 81
system procedures
  ml_delete_device, 81
  ml_delete_device_address, 81
  ml_delete_listening, 82
  ml_set_device, 82
  ml_set_device_address, 83
ml_set_listening, 84
ml_set_sis_sync_state, 85
MobiLink server-initiated synchronization, 81

T

tutorials
    server-initiated synchronization, 91
    server-initiated synchronization using gateways, 104
    server-initiated synchronization using light weight polling, 91

U

UDP gateway
    MobiLink listening libraries for server-initiated synchronization, 51
    using gateways as an alternative to light weight pollers, 19
UDP gateway properties
    MobiLink about, 47
utilities
    MobiLink Listener (dblsn) syntax, 49

W

window classes
    posting window messages to, 69
window messages
    posting in server-initiated synchronization, 69